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1.1 INTRODUCTION 

ISODAT NT is a software suite for system control, data acquisition and data evaluation that is 

an integral part of the system architecture. 
 

¾ 

¾ 

¾ 

¾ 

System control 
All aspects of the mass spectrometer are controlled by software, including ion 

generation, mass separation and ion detection. Control of the ion source allows 

manual tuning, auto tuning, as well as storage and retrieval of ion source parameters.  

Different system configurations representing different analytical setups can be stored 

and retrieved. Up to eight simultaneous data acquisition streams are supported. 
 

Automation 
The system is designed to fully automatically execute pre-defined procedures and run 

sequences of analyses, including customized reporting. 
 

Open architecture 
ISODAT Script Language (ISL) is the tool giving the expert user full access to the 

mass spectrometer, the inlet systems and additional user-supplied devices. An input-

output module allows connection and control of up to five interfaces. Scripts can be 

developed for customized applications. 
 

Data evaluation and display 
ISODAT NT provides a comprehensive set of customizable data evaluation routines. 

Standard report forms are provided according to the application. In addition, reports 

can be easily customized using ISODAT NT's Result Workshop. 
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Technical information contained in this publication is for reference purposes only and is 

subject to change without notice. Every effort has been made to supply complete and 

accurate information. However, Thermo Finnigan assumes no responsibility and will not be 

liable for any errors, omissions, damage, or loss that might result from any use of this manual 

or the information contained therein (even if this information is properly followed and 

problems still arise). 

 
This publication is not part of the Agreement of Sale between Thermo Finnigan and the 

purchaser of a Thermo Finnigan MAT system. In the event of any conflict between the 

provisions of this document and those contained in Thermo Finnigan's Terms and Conditions, 

the provisions of the Terms and Conditions will govern. 

 
Reference to System Configurations and Specifications supersede all previous information 

and are subject to revision without notice. 
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1.2 INSTALLATION OF BOARD DRIVERS 

The following pages contain descriptions for the installation of drivers for the various 

extension boards of the computer. 

1.2.1 "SERIAL SOLUTIONS" COM PORT EXTENSION BOARD DRIVER 

The PCI Dual RS 232 Card is already part of your computer. Its driver by "Serial Solutions 

Products" makes available two additional COM Ports. Thus, install it only, if your computer is 

equipped with merely one COM Port. 

Install it once only, namely when you newly install your operating system. 

Close all other applications! Otherwise, an error message might occur. 
 

If your computer hangs up during either installation or reboot, shut it 
down and try to install again. 
If your system hangs up again, plug the PCI Dual RS 232 Card to another slot. 

Then only start your system without reinstallation. 

¾ To install the driver, insert the "Serial Solutions" CD into your drive and close it. The CD is 

shipped with your system. 

¾ If Auto Run is deactivated on your computer, press the Start 
button and then Run. 

 

 

 

 

 

 

 

 

¾ Click Browse. 
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¾ Select your CD drive e.g. 

E:\Vscomdriver. From the Files of 
type pulldown menu choose All Files 
(*.*). Click the file Start.html and then 

Open (or double-click Start.html). 
 

 

 

 

 

¾ Press OK. 

 

 

 

 

 

 

 

¾ Wait, while the DemoShield is initializing. 

 

 

 

 

 

¾ On the Installation Screen, click Software. 
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¾ Press Current. 
 

 

 

 

 

 

 

 

 

 

 

¾ Click Windows NT. 

 

 

 

 

 

 

 

 

 

 

¾ Press Install. 
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¾ Wait, while Setup is preparing the InstallShield® 

Wizard. 

 

 

 

 

 

 

 

 

 

 

¾ Carefully read the instructions about closing all 

applications and copyright law. Click Next to 

continue.  

(If Setup has found a previously installed 

version, continue as described below). 

 

 

 

 

 

 

¾ Wait, while Setup is copying the files. 
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¾ Serial Solutions for Win NT has been 

installed on your computer. 

 

 

¾ Click Finish to complete Setup. 

 

 

 

 

 

 

 

 

 

 

¾ Press the House button. 

 

 

 

 

 

 

 

 

¾ Click Quit. Then reboot your system. 
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1.2.1.1 REINSTALLING A PREVIOUSLY INSTALLED SERIAL SOLUTIONS DRIVER 

¾ "Serial Solutions" Setup has detected a 

previously installed version. 

 

¾ Choose Re-install. 
 

 

 

 

 

 

 

¾ Select Yes, I want to restart my computer now 

and press OK to reboot. 

 

 

NOTE: If your computer hangs up during either installation or reboot, 
shut it down and try to install again. 
If your system hangs up again, plug the PCI Dual RS 232 Card to 
another slot. Then restart your system without reinstallation 

 

1.2.2 INSTALLING IEEE INTERFACE BOARD DRIVERS 

Some peripherals (e.g. equilibration unit, carbonate device) require the installation of an IEEE 

board in the computer. The installation of the driver for this board is described on the 

following pages. 
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1.2.2.1 "NATIONAL INSTRUMENTS" GPIB PCI IEEE BOARD - INSTALLATION 

Install the driver from the "National Instruments" NI 488.2 CD shipped with 

your system. 

If Adobe Acrobat Reader is not installed on your computer, it can be installed 

later. It will be needed to read "National Instruments" Help files. 

 

¾ Close all other applications! 
Insert the CD into your CD drive and close it. The 

box shown above appears. 

¾ Click Install NI-488.2 Software for Windows 

(turning into blue). 

 

 

 

 

 

 

¾ Wait, while Installation is being prepared. 

 

 

 

 

 

¾ Wait, while the NI-488.2 Installation Wizard appears 

and searches for previously installed applications. 
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¾ Click Next. 
 

 

 

 

 

 

 

¾ Carefully read the "National Instruments" Software 

License Agreement. To continue press Yes. 

 

 

 

 

 

 

 

 

¾ Take your registration decision. Then press Next. 
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¾ To select the destination directory, either accept the 

proposed path and press Next or select another one 

by the Browse button. 

 

 

 

 
¾ If you pressed the Browse button, a box appears. 

From the Location of folder pulldown menu, 

choose the alternative destination folder. Note the 

according entry in the Selected Path box. Finally, 

press OK. 

 

 

¾ Select the Installation type.  

Typical is recommended for most users, while 

Custom is recommended for advanced users.  

Finally, press Next. 
 

 

 

 

 

 

¾ The NI-488.2 software is now ready to be installed. 

To begin the Installation press Next. 
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¾ Wait, while Initialization begins. 

 

 

 

 

 

 

¾ If you did not close all other applications yet (as was 

recommended, you are reminded to do it now: 

Click on the open applications' entries right to the 

Start button and close all of them. 

Finally, press Retry. 

 

 

 

 

 

 

 

¾ Wait while the Initialization is terminated. 
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¾ Wait, while the files are copied. 

 

 

 

 

 

 

 

¾ Possibly, you might be reminded that Acrobat 

Reader 3.0 (or higher) was not found on your 

system. 

It is necessary to read "National Instruments" 

documentation files, but you can install them later. 

Press Next. 
 

 

 

 

 

 

¾ This box informs about the separate NI-VISA 

Installation. This will be done after this installation is 

finished (see Chapter 1.2.2.4). 

Click Next. 
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¾ The NI-488.2 Software has been successfully 

installed. Click Finish. 

 

 

 

 

 

 

 

¾ On your desktop, note the new NI-Icon. 
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1.2.2.2 "NATIONAL INSTRUMENTS" GPIB PCI IEEE BOARD - CONFIGURATION 

After having installed the GPIB PCI driver, configure it now as shown below. 

¾ To configure it press Start > 
Programs > National Instruments > 
NI 488.2 > Getting Started. 

 

 

 

 

 

¾ Point at Configure your GPIB Interface with your 

mouse and click. 

 

 

 

 

 

 

¾ On the next window, click on the Next button to 

begin the Configuration. 

 

 

 

 

 

 

¾ On the following window, press the Board Type 

button. 
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¾ From the Board Type pulldown list on the right, select 

PCI-GPIB. Press OK. 
 

 

 

 

 

 

¾ Press Configure. 
 

 

 

 

 

 

 

¾ Press Software >>. 
 

 

 

 

 

 

 

¾ On the next window, tick the 

checkboxes as shown in the figure right. 

Then click the OK button and confirm by 

OK on the following window 

(see above). 
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The configuration is finished now and the system starts the verification of the board driver 

(see Chapter 1.2.2.4).  

 

Under some circumstances, the following window may appear. 
 

 

 

¾ The error statement shown on the message box in the 

figure right indicates that the software cannot be 

started. Press OK to close the window.  

Check whether your Interface Card is properly 

inserted and then repeat the configuration of the 

GPIB-PCI driver. 

 

 

 

1.2.2.3 "NATIONAL INSTRUMENTS" GPIB PCI IEEE BOARD - VERIFICATION 

After installing and configuring your GPIB-PCI driver, verify it now as shown below. 
 

 

 

 

¾ Point at Verify your hardware and software 
installation and click. 
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¾ The NI-488.2 Software, GPIB Hardware and GPIB 

Interface(s) are successively being verified. 

A blue mark ( ) indicates successful verification. A 

red mark ( ) indicates that verification failed. 

If the red mark indicates that verification of your 

GPIB interface failed, press Help and finally Retest. 
 

 

1.2.2.4 "NATIONAL INSTRUMENTS" GPIB PCI IEEE BOARD - VISA INSTALLATION 

After having installed the NI-488.2 Software, the program "NI-Visa" will now be installed. 

Close all applications! 
 

 

 

 

¾ Press the Start button on the taskbar. 

 

 

 

 

 

 

 

 

 

¾ Press Browse. 
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¾ At the Look in pulldown menu, select your CD drive 

[e.g. Ni4882 (F:)]. 

 

¾ Select SetupVisa.exe and press Open (or double-

click SetupVisa.exe). 

 

 

 

 

 

¾ The path to SetupVisa.exe appears. Click OK. 

 

 

 

 

 

¾ Wait, while the Installation program is being 

prepared.  

 

 

 

 

 

 

¾ You are reminded to close all applications. 

To do so, if necessary, see how to exit Visa Setup. 

Then press Next. 
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¾ If the Setup program detects previously installed NI-

Visa components, either add / remove some of them 

or choose reinstall / reinstall mode.  

 

 

 

 

 

 

¾ Read the License Agreement carefully and click 

Agree to proceed. 

Disagree would lead to exit Visa Setup. 

 

 

 

 

¾ The Installation program proposes a destination 

folder for the NI-Visa Software (e.g. C:\VXlpnp\). To 

choose another folder, press the upper Browse 

button. 

In case of a previous NI-Visa installation, this button 

is disabled and the NI-Visa Software will be installed 

in the proposed folder. 

¾ Beneath it, another folder is proposed for the 

installation of other NI Software (e.g. C:\Program 

Files\National Instruments\). 

To choose another folder use the lower Browse 

button. Finally, click Next. 
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¾ Choose a folder (for the other NI Software). In the 

Folder Name box, the respective path is displayed. 

Press OK. 

 

 

 

¾ To install all features select Complete 

(recommended usually) and press Next or use 

Custom (for advanced users) to install selected 

features and press Next. 
 

 

 

 

 

 

¾ To start installing the files press Next. 
 

 

 

 

 

 

¾ Wait, while initializing takes place. 
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¾ Wait, while the files are being copied. 

 

 

 

 

 

 

 

 

¾ After NI-Visa has been successfully installed press 

Finish. 

 

 

 

 

 

 

¾ Click Yes to reboot your system now. 

 

 

 

1.2.3 INSTALLATION OF THE SOUND CARD DRIVER 

The installation of a sound card is required when a GC application is used as peripheral. The 

GC communicates with the IRMS via the joystick port of the sound card. 

¾ Insert the sound card into slot #5. 

¾ For the installation of the respective sound card driver, follow the instructions in the 

manual of the sound card manufacturer. 
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1.2.4 INSTALLATION OF THE "ANALOG JOYSTICK" DRIVER 

The following GC applications additionally require the "Analog Joystick" driver. The GC 

communicates with the IRMS via the joystick port of the sound card. 

¾ HP 6890 GC 

¾ Trace GC 

¾ any other "generic" GC  

NOTE: The successful installation of a sound card with the appropriate driver is a 
prerequisite for the installation of the joystick driver. 

 

For Joystick driver handling follow the steps below: 

 

To install it insert the "Operating System Backup CD" and follow the steps below.  

 

 

 

¾ Close the appearing box via the button ( ) at top 

right corner. 

 

 

 

 

 

 

 

¾ Press Start > Settings > Control Panel. 
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¾ Double-click the Multimedia Icon. 

 

 

 

 

 

 

 

 

¾ Click the Devices tab.  

 

 

 

 

 

 

 

 

¾ Press the Add button.  

 

 

 

 

 

¾ Select Unlisted or updated driver and click OK. 
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¾ Insert the "Operating System Backup CD" containing the 

driver - as was already recommended in Step 1. Type the 

letter of your CD drive (e.g. e:\) and click Browse. From the 

Drives pulldown list select your CD drive (e.g. e: NTWKS 

40A). In the Directories pulldown list double-click the folders, 

which successively lead to the Joystick drivers (e.g. 

e:\drvlib\multimed\joystick\x86). 

¾ Click OK. 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ Select Analog Joystick Driver and click 

OK. 

 

 

 

 

¾ If the required joystick.dll driver is already 

installed: 

press New to install a new driver, or press 

Current to use the current driver. 
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¾ In both cases, the box above appears. 

The different settings determine the 

communication of Windows with the 

joystick(s). 

If you are unsure of which settings to use, 

keep the default settings. 

Then click OK. 

 

 

 

 

 

¾ Click Restart Now. 

 

 

 

 

1.2.4.1 CALIBRATING THE JOYSTICK DRIVER 

After the installation of the Joystick driver, it must now be calibrated and finally tested. 

To calibrate it, follow the steps below. 

 

 

 

 

¾ Press Start > Settings > Control Panel. 
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¾ Double-click the Joystick Icon. 

 

 

 

 

 

 

 

 

 

 

 

 

¾ At Joystick Configuration, select the 

Calibrate button. 

 

An error message occurs, if the joystick is 

not correctly connected. 
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¾ To set the joystick's position, leave its handle 

centered. 

Then press one of the joystick's buttons. 

Click Next. 
 

 

 

 

 

 

¾ To set the joystick's motion range, move the 

handle in complete circles several times. 

Then press one of the joystick's buttons. 

 

 

 

 

 

 

 

¾ The joystick has been calibrated successfully. 

Click Finish to save your calibration settings. 

 

 

¾ Test the calibration (see below). 
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1.2.4.2 TESTING THE JOYSTICK'S CALIBRATION 

 

 

 

 

 

¾ Press Start > Settings > Control Panel. 
 

 

 

 

 

 

 

 

 

 

¾ Double-click the Joystick Icon. 
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¾ At Joystick Configuration, select the Test 
button. 

An error message occurs, if the joystick is 

not correctly connected. 

 

 

 

 

 

 

 

 

 

¾ To test the Joystick's calibration, move the 

Joystick. 

 

Click OK. 

 

Press one of the Joystick's buttons. 
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¾ One of the fields is lighted red (e.g. "Button 1"). 

Press the other button. 

 

 

 

 

 

 

 

 

 

¾ The other field is lighted red (e.g. "Button 2"). 

Press OK. 

 

 

 

 

 

 

1.2.5 GC AND AUTOSAMPLER REQUIREMENTS 

 

1.2.5.1 HP 6890 GC 

¾ Gameport Interface (in the PC) 

¾ Gameport cable (ATT: modified version, two resistors) 

¾ Serial cable from PC to HP 6890 (Null Modem 2X3) - Default: COM 2 
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1.2.5.2 TRACE GC 
 

¾ Gameport Interface (in the PC)  

¾ Gameport cable from PC to Trace GC 

¾ Serial cable from PC to Trace GC (Null Modem 2X3) - Default: COM 2 

 

1.2.5.3 ANY OTHER "GENERIC" GC 
 

¾ Gameport Interface (in the PC) 

¾ Gameport cable from PC to any other "generic" GC (only Trigger Mode) 

 

 

1.2.5.4 A200S OR PAL AUTOSAMPLER 
 

¾ Serial cable from PC to A200S Autosampler - Default: COM 1 

¾ Cable for "GC ready" status from Autosampler to GC 
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1.3 INSTALLATION OF ISODAT NT 
 

1.3.1 SYSTEM REQUIREMENTS 
To use ISODAT NT optimally, meet some system prerequisites. ISODAT NT needs certain 

¾ Software requirements and  

¾ Hardware requirements.  

 

1.3.1.1 SOFTWARE REQUIREMENTS 
It is advantageous if your system meets the recommended requirements. 

Software requirements (minimal) Software requirements (recommended) 

Windows NT 4.0 (Intel) operating system Windows NT 4.0 (Intel) operating system 

Pentium class computer (233 MHz) Pentium class computer (400 MHz or higher)

96 MB RAM 128 MB RAM 

100 MB free disk space 

(only for ISODAT NT, without Backups and 

Result files) 

500 MB free disk space (or higher) 

Super VGA monitor (resolution 768 * 1280 

pixels) 

Super VGA monitor (resolution1280 * 1024 

pixels) 

 Windows NT 4.0 supported printer 

 

1.3.1.2 HARDWARE REQUIREMENTS 
¾ COM Port Extension Board 

¾ IEEE Interface Board (for some peripherals) 

¾ Sound Card (when a GC application is used as peripheral) 

¾ Joystick requirements (when a GC application is used as peripheral) 

¾ GC and Autosampler requirements 

For the installation of the drivers for the above listed hardware, refer to Chapter 1.2. 
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1.3.2 INSTALLATION PROCEDURE 
Now install ISODAT NT (shipped on the CD). This can be done via the Startup Screen. 

 

 

Close all applications (especially older versions of ISODAT NT if already 
installed and running)! 
Otherwise, a message will indicate that Setup of ISODAT NT is not possible 

while older versions of ISODAT NT are running (see: how to shut down the 

system). 

 

 

¾ Open your CD drive and insert the ISODAT NT CD. 

¾ Close it. 

 

If your CD ROM drive is set to Autostart, the file startup.html on the 
ISODAT NT CD will be executed and the gray HTML startup screen will 
appear. 
 

 

 

 

¾ From the gray Startup Screen, select 

Install ISODAT NT. 
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¾ Select Run this program from its 

current location. Then press OK. 

 

 

 

 

 

 

 

 

 

 

 

¾ Click Yes. 

 

 

 

 

 

 

 

 

¾ Wait while Setup is preparing the InstallShield® 

Wizard.  
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¾ Respond with Yes (No will not create a backup).  

Make sure that you have enough free disk space for the backup 

that includes your Result files. 

 

¾ A backup of the current version of ISODAT NT is created 

and stored in a subdirectory, e.g. "Version_0.50", of the 

folder C:\Isodat_Backups (if you cancel the backup, a 

message occurs). 

� Each backup includes your Result files and is stored in a subdirectory of its own 

in the folder C:\Isodat_Backups.  

� Backups can be created and restored by using the Version Handler in the folder 

C:\Isodat_Backups.  

 

¾ Respond with Yes to delete a previous version. 

 

 

Yes leads to loss of Configurations and measurement data. 
No will overwrite the previous version. Data, Configurations and Mass 
Calibrations will remain untouched. 
Even though, it is recommended to delete old versions until unequivocal 
compatibility between the old and the new version is ensured. 

 

¾ No will overwrite the previous version. Data, Configurations 

and Mass Calibrations will remain untouched. Even though, it 

is recommended to delete old versions until unequivocal com- 

patibility between the old and the new version is ensured. 

¾ Confirm again with Yes to delete. 
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¾ Read the text carefully and click Next. 
 

 

 

 

 

 

 

 

¾ Read the software license agreement carefully 

and click Yes. 

 

 

 

 

 

 

 

¾ Fill in your name and company. Then click Next. 
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¾ On the next window, you have to indicate whet- 

her you have interfaces installed.  

As default, both checkboxes are selected. Select 

the checkbox(es) that correspond to your equip- 

ment, and then press Next. 
� When you have ticked the checkbox 

Fiber Line Interface, proceed with 

Page 1 – 39. 

� When you have ticked the checkbox 

IEEE (GBIB) Interface, proceed with 

Page 1 – 38. This is also the case, when 

you have ticked both checkboxes. 

 
¾ When you have deselected both checkboxes, 

the following window appears. Select the radio 

button DeltaPlusXP/Advantage/253 and press 

Next. 
This will install the Fake Mode, which can be 

used for offline computer systems and software 

testing purposes. Proceed with Page 1 – 39. 

 

¾ Select your MS Interface Board for IEEE connec- 

tion to the IRMS (on the rear side of your compu- 

ter). Click Next. 
� The "National Instruments" PC IIA (ISA) 

driver will automatically be installed.  

� The "National Instruments" PCI-GPIB 

(PCI) driver must be installed separately 

later. 
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¾ Having chosen PCI-GPIB (PCI), you are reminded that 

the "National Instruments" PCI-GPIB driver must be in- 

stalled separately later using the "National Instruments" 

CD. 

Ensure that the appropriate IEEE Interface board driver 

has been installed. The required cables are part of the 

delivered equipment.  

¾ Press OK. 

 

 

 

¾ Accept the proposed folder or choose another 

one by the Browse button. Then press Next. 
 

 

 

 

¾ Wait while Setup is updating the registry. 

 

 

 

 

 

¾ Wait while Setup is copying ISODAT NT onto 

your harddisk. 
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¾ Choose Yes, I want to restart my computer 
now. 

 

¾ Remove the CD. 

 

¾ Click Finish to reboot. ISODAT NT is now 

installed on your computer.  
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ISODAT NT 
 
 

OPERATING MANUAL 
 
 
 
 
 
 
 
 
 
 
 

CONFIGURATOR 
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2.1 PRINCIPLE 
 

The Configurator creates an image of the hardware of your isotope ratio mass spectrometer 

(IRMS) resulting in a Configuration in the Configurations tree structure (i.e. Hardware Confi-

guration). A Configuration always contains the IRMS and selected peripherals, representing 

all components necessary for a specific application. See an example. 

 
Configuration procedure 

 
1 Defining hardware components of the IRMS 

 

¾ Select Mass Spectrometer 

¾ Edit Cup Settings 

¾ Edit Gas Configurations 

 
2 Defining particular Configurations 

 
 
2.2 STARTING THE CONFIGURATOR 
 

¾ On the desktop, click the Isodat NT button twice. 
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Alternative: 

¾ Press Start > Programs > Isodat NT > Configurator. 
   

 

 

 

 
¾ Double-click the Configurator Icon. 

 

 

If ISODAT NT is already running, the Configurator can not be started. 

An error message is displayed: Shut down the system, then start the Confi- 

gurator again. 
   

  

 
¾ The Configurator opens. 
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Left pane:  lists all defined Configurations beneath the "Isodat NT" folder. 

  If you have never before defined one, it is the only one to be dis- 
  played. 

 It has been assigned the preliminary name "New Configuration" 
  which can be changed easily. 

Middle pane:  five "Sets" tabs leading to the generally possible hardware combi- 
   nations.  

Right pane:  select those predefined hardware combinations which fit to your 
   instrument. 

2.3 SELECT MASS SPECTROMETER 

Selecting the IRMS type defines mass spectrometer specific parameters (e.g. magnetic field, 

high voltage, pressure meters). 

 

 

 

The above box is shown only when starting the Configuration procedure the first time. 

In the background window's left pane the "Isodat NT" folder is visible. All Configurations 
added later will be listed beneath it. Hitherto, no Hardware Configuration is defined. 

¾ Select your IRMS among the available mass spectrometer types. 
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2.3.1 RESET MASS SPECTROMETER 
 
 

 

 

 

 
¾ To select another IRMS click Reset Spectrometer in the Edit menu. 

 
 

 

 

 

 
 

 
All existing Configurations will be deleted answering "Yes"! 

 
¾ Proceed with Yes, while No cancels the process. 
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¾ Select your IRMS among the available Mass Spectrometer types. 

 

2.4 ADDING NEW CONFIGURATIONS 

After defining the IRMS a Configuration (i.e. a Hardware Configuration) must be esta- 

blished. To create one, your peripherals must be attached to the inlet port of the mass 
spectrometer. 

 

 

 

  
¾ In the Edit menu select Add Configuration.  
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Alternative: 

¾ Click the Add new Configuration Icon on the toolbar.  

 

Definition of a Configuration by attaching peripherals will be explained by examples: 

Example 1: Attaching a Dual Inlet peripheral to the IRMS 

Example 2: Attaching a GC peripheral to the IRMS 

Example 3: Attaching a ConFlo peripheral to the IRMS 

Example 4: Attaching a GasBench peripheral to the IRMS 

 
2.4.1 ATTACHING A DUAL INLET PERIPHERAL TO THE IRMS 
 

A "Dual Inlet + Multiport" peripheral will be connected to a DeltaPlus Mass Spectrometer. 

  

 
¾ In the Configurator's left pane beneath the "Isodat NT" folder, the Configuration being 
 created occurs ("New Configuration"). Hitherto, a capillary is displayed close to it ser- 
 ving as default symbol. 

 
¾ Beneath the "New Configuration" entry the mass spectrometer you chose can be seen
 (e.g. a DeltaPlus). Pressing its + sign shows all IRMS parts in the tree structure. 

 



 
 

ISODAT NT           C O N F I G U R A T O R 2 
 
 

 
2 – 7 

 
     

 
Issue 06/2002 

 

 

 

 

 
¾ Press the Dual Inlet Sets tab in the middle pane. 

 
¾ Select the peripheral to be attached to the IRMS by a click on it in the right pane 

 
 (e.g. Dual Inlet + Multiport). 
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¾ Drag and drop the selected entry (e.g. "Dual Inlet + Multiport") to the 

 Source symbol of the MS DeltaPlus, at bottom of left pane.  

 

  

 
¾ The Dual Inlet periphery has been inserted beneath the Source symbol (beginning at 

 the "Dual Inlet System" entry). 

 

 

The capillary Icon on the left side of "New Configuration" has changed to a 
bellows Icon. ISODAT NT automatically detects that a Dual Inlet periphery is 
being attached and indicates this by the bellows Icon. 

 
¾ Rename the new Configuration hitherto called "New Configuration". This could also 

 already be done when the entry "New Configuration" appears the first time. 

 

¾ Choose a significant name to identify it easily if creating more than one Configuration 

 (e.g. "Dual Inlet + Multiport"). 
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¾ Right-click on New Configuration. 

¾ In the popup menu select Rename. 

Alternative: 

¾ From the Edit menu select Rename. 
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¾ Type the name of the new Configuration (e.g. "Dual Inlet + Multiport"). 

¾ Click somewhere on the screen to finish renaming. 

 
 
2.4.2 ATTACHING A GC PERIPHERAL TO THE IRMS 
 
A "GC II-III Interface + Standard GC" periphery will be connected to a DeltaPlus Mass 

Spectrometer. 

 

  

 
¾ In the Configurator's left pane beneath the "Isodat NT" folder, the Configuration being 

 created occurs ("New Configuration"). Hitherto, a capillary is displayed close to it ser- 

 ving as default symbol. 

 

¾ Beneath the "New Configuration" entry the mass spectrometer you chose can be seen

 (e.g. a DeltaPlus). Pressing its + sign shows all IRMS parts in the tree structure. 
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¾ Press the GC Sets tab in the middle pane. 

¾ Select the peripheral to be attached to the IRMS by a click on it in the right pane 

 (e.g. GC II-III Interface + Standard GC). 
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¾ Drag and drop the selected entry (e.g. "GC II-III Interface + Standard GC") to

 the "Capillary" symbol of the MS DeltaPlus, at bottom of  left pane. 

 

 

 

 

 
¾ The GC periphery has been inserted beneath the "Capillary" symbol (beginning at the 

 "GC II-III Interface" entry). 

 

 

The capillary Icon on the left side of "New Configuration" has not changed. 

ISODAT NT automatically detects that a GC periphery is being attached and 
indicates this by the capillary Icon. 

 
¾ Rename the new Configuration hitherto called "New Configuration". This could also 

 already be done when the entry "New Configuration" appears the first time. 

 

¾ Choose a significant name to identify it easily if creating more than one Configuration 

 (e.g. "GC II-III Interface + Standard GC"). 
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¾ Right-click on New Configuration. 

¾ In the popup menu select Rename. 

 

Alternative: 
 

¾ From the Edit menu select Rename. 
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¾ Type the name of the new Configuration (e.g. "GC II-III Interface + Standard GC"). 

¾ Click somewhere on the screen to finish renaming. 

 
 
2.4.3 ATTACHING A CON FLO PERIPHERAL TO THE IRMS 
 
A "ConFloII + Elemental Analyzer + Autosampler" peripheral will be connected to a DeltaPlus 

XL Mass Spectrometer. 

 

 

 

 
¾ In the Configurator's left pane beneath the "Isodat NT" folder, the Configuration being 

 created occurs ("New Configuration"). Hitherto, a capillary is displayed close to it ser- 

 ving as default symbol. 

¾ Beneath the "New Configuration" entry the mass spectrometer you chose can be seen

 (e.g. a DeltaPlus XL). Pressing its + sign shows all IRMS parts in the tree structure. 
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¾ Press the ConFloII Sets tab in the middle pane. 

¾ Select the peripheral to be attached to the IRMS by clicking on it in the right pane 

 (e.g. ConFloII + Elemental Analyzer + Autosampler). 

 

 

 

 

  
¾ Drag and drop the selected entry (e.g. "ConFloII + Elemental Analyzer 

 + Autosampler") to the "Capillary" symbol of the MS DeltaPlus XL, at 

 bottom of left pane. 
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¾ The ConFlo periphery has been inserted beneath the "Capillary" symbol 

 (beginning at the "ConFloII Interface" entry). 

 

 

The capillary Icon on the left side of "New Configuration" has not changed. 

ISODAT NT automatically detects that a ConFloII periphery is being attached 
and indicates this by the capillary Icon. 

 
¾ Rename the new Configuration hitherto called "New Configuration". This could also 

 already be done when the entry "New Configuration" appears the first time. 

 

¾ Choose a significant name to identify it easily if creating more than one Configuration 

 (e.g. "ConFloII Interface + Elemental Analyzer + Autosampler"). 

 

 

 

 

 
¾ Right-click on New Configuration. 

¾ In the popup menu select Rename. 

Alternative: 

¾ From the Edit menu select Rename. 
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¾ Type the name of the new Configuration (e.g. "ConFloII Interface + Elemental 

 Analyzer + Autosampler"). 

 

¾ Click somewhere on the screen to finish renaming. 

 
 
2.4.4 ATTACHING A GASBENCH PERIPHERAL TO THE IRMS 

A "Gasbench + Autosampler" peripheral will be connected to a DeltaPlus XL Mass 

spectrometer. 
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¾ In the Configurator's left pane beneath the "Isodat NT" folder, the Configuration being 

 created occurs ("New Configuration"). Hitherto, a capillary is displayed close to it ser- 

 ving as default symbol. 

¾ Beneath the "New Configuration" entry the mass spectrometer you chose can be seen

 (e.g. a DeltaPlus XL). Pressing its + sign shows all IRMS parts in the tree structure. 

 

 

 

 

 
¾ Press the ”Gasbench Sets” tab in the middle pane. 

¾ Select the peripheral to be attached to the IRMS by a click on it in the right pane 

 (e.g. Gasbench + Autosampler). 
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¾ Drag and drop the selected entry (e.g. "Gasbench + Autosampler") to 

 the "Capillary" symbol of the MS DeltaPlus XL, at bottom of left pane.  

 

  

 
Particularity of Gasbench peripherals: 

¾ Deselect or select optional Hardware by marking or not marking the items. 

 

  

 
¾ The GasBench peripheral has been inserted beneath the "Capillary" symbol 

 (beginning at the "GasBench" entry). 
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The capillary Icon on the left side of "New Configuration" has not changed. 

ISODAT NT automatically detects that a Gasbench peripheral is being atta- 

ched and indicates this by the capillary Icon. 
 
¾ Rename the new Configuration hitherto called "New Configuration". This could also 

 already be done when the entry "New Configuration" appears the first time. 

 

¾ Choose a significant name to identify it easily if creating more than one Configuration 

 (e.g. "Gasbench + Autosampler"). 

 

 

 

 

 

¾ Right-click on New Configuration. 

¾ In the popup menu select Rename. 

Alternative: 

¾ From the Edit menu select Rename. 
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¾ Type the name of the new Configuration (e.g. "Gasbench + Autosampler"). 

¾ Click somewhere on the screen to finish renaming. 

 
 
2.4.5 DELETING CONFIGURATIONS 
 
 

 

 

 

 
¾ In the Configurator's left pane, click on the Configuration 

 (e.g. "Gasbench + Autosampler"). 
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¾ On the toolbar, press the Delete button. 
 

   

 

 

 

Alternative: 

¾ Right-click the Configuration and select Delete from the popup menu. 

 

  

 
¾ Confirm by Yes. No cancels the process. 
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2.5 EDITING CUP SETTINGS 

The box below automatically appears after selecting the IRMS type. 

 

¾ Installed cups are marked in the left column. Only 

marked cups will be available in "Gas 

Configurations". 

¾ Cups available for Peak Center are marked in the 

middle column. Peak Center is only recommended on 

narrow cups. 

¾ The resistor values of the cups are shown and edited 

in the right column. 

 

 

Ensure the Cup Settings are matching your IRMS configuration. 

For specific Cup Settings consult the system's technical information. 
 
¾ Select the particular fields, type in the correct numbers or select a resistor value from 

 the pulldown list. 

 

 
Resistor values influence: 

¾ Continuous Flow area determinations 

¾ Diagnosis results 

¾ H3-factor determination 

 



 
 

ISODAT NT           C O N F I G U R A T O R 2 
 
 

 
2 – 24 

 
     

 
Issue 06/2002 

 

 

 

 
¾ To change Cup Settings at later times select Cup Settings from the Configura- 

 tor's Edit Menu. 
 

 
Alternative: 

¾ Click the Modify Cup Settings Icon on the toolbar.  

 
2.5.1 EXAMPLES OF CUP SETTINGS - 1. DELTAPLUS XL 
 

¾ Cups 2 - 4: 

N2-Cups and 

CO2-Cups  

 

¾ Cups 1 + 8: 

H2-Cups 
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Universal Triple Detector: Cup 2 - Cup 4 

Peak Centering can only be performed on Cup 3 (narrow cup). 

Measurements of CO2, N2 are performed on the same Cups (Cup 2, 3 and 4) and with 

the same resistor values. 
 

HD Detector:   Cup 1 + Cup 8 

Peak Centering for H2 is performed on Cup 8 (narrow cup). 

 
2.5.2 EXAMPLES OF CUP SETTINGS - 2. DELTAPLUS 
 
 

¾ Cups 1 - 3: 

N2-Cups and 
CO2-Cups 

 

¾ Cups 7 - 8: 

H2-Cups 

 

NOTE: The Delta Plus Cup Settings are identical with Delta C, but additionally a 
 H2-option exists. 

Universal Triple Detector: Cup 1 - Cup 3 

Peak Centering can only be performed on Cup 2 (narrow cup). 
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Measurements of CO2, N2 are performed on the same Cups (Cup1, 2 and 3) and 

with the same resistor values. 

HD Detector: Cup 7 - Cup 8 

Peak Centering is possible on both cups. 

 
2.5.3 EXAMPLES OF CUP SETTINGS - 3. DELTA S AND MAT 252 
 

¾ Cups 1 - 3: 

 N2-Cups 

 

¾ Cups 4 - 6: 

CO2-Cups 

 

¾ Cups 7 - 8: 

H2-Cups 

 

MEMCO Detector: Cup 1 - Cup 6 

Peak Centering is possible on all cups, because all cups are narrow. 

HD Detector:  Cup 7 - Cup 8 

Peak Centering is possible on both cups. 
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2.5.4 EXAMPLES OF CUP SETTINGS - 4. DELTA C 
 

¾ Cups 1 - 3: 

 N2-Cups and 

 CO2-Cups 

 

 

Universal Triple Detector: Cup 1 - Cup 3 

Peak Centering can only be performed on Cup 2 (narrow cup). 

Measurements of CO2 and N2 are performed on the same Cups (Cup1, 2 and 3) 

and with the same resistor values. 

 

2.6 EDITING GAS CONFIGURATIONS 
 
A Gas Configuration is the information pattern about the gases to be analyzed, the isotope 

masses of interest and their corresponding cups. Furthermore, data about PC-Offset, magnet 

information and Calibrations are given in the "Gas Configurations" window. 

 

Green marked cups indicate peak centering availability. White marked ones are 

installed, but not available for peak centering. Grey marked ones are not installed 

(undefined). 
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Type the chemical formulas of the gases to be analyzed in the "Formula" 
column! 

Typing it only in the "Name" column is not sufficient! 
 

 

 

 

 

 
Ensure that the Gas Configurations are matching your IRMS configuration. 

 
¾ Select the particular fields, type in the correct numbers or choose them from the 

 pulldown list. 

¾ When all changes are made press Close. 
 
 
2.6.1 CHANGING GAS CONFIGURATIONS 
 

 

 

 

 
Alternative: 

Click the Gas Configuration button on the toolbar. 

Proceed as shown on Page 2 – 27. 
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2.6.2 ADDING GAS CONFIGURATIONS 
 

 

 

 

 
¾ From the Configurator's Edit menu select Gasconfiguration. 

 

 

 

 

 
¾ Press the New button. 

 

  

 
¾ In the Name edit box, type the Gas Configuration's name, e.g. "CO". 

 Choose it as you like. It must not necessarily be a gas name, but is recommended. 

¾ From the Template pulldown menu, select the gas. 
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2.6.3 DELETING GAS CONFIGURATIONS 
 

 

 

 

 
¾ From the Configurator's Edit menu select Gasconfiguration. 

 

 

 

 

 

¾ Select one or more Gas Configurations to delete. 

¾ Press the Del button. 

 

 

 

 

 
¾ Confirm by Yes. 

¾ Close the Configurator. 
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2.6.4 EXAMPLES FOR GAS CONFIGURATIONS 
 

1. DeltaPlus XL 
   

  

 
2. DeltaPlus 

   

  

 
3. Delta S and MAT 252 
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4. Delta C 
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3.1 MASS CALIBRATION 
 
3.1.1 OPEN INSTRUMENT CONTROL 

¾ Open the Isodat NT window on the desktop. 
 

 

  

¾ Start Instrument Control by a double-click on the Instrument Control Icon.  

 

¾ The Instrument Control window appears.  
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3.1.2 PREPARE CALIBRATION 
 
 

   

 
¾ Select a Gas Configuration (e.g. "CO2"). 

¾ Select a Configuration (e.g. "Dual Inlet + Multiport"). 

¾ Ensure that a Reference Gas container (e.g. CO2) is attached to the hardware of the 

 selected Configuration. 

 

 

 

 

 
¾ Click to activate Reference Gas (e.g. GC II-III Interface). 
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3.1.3 START CALIBRATION 
 
 
¾ Activate the Scan Window by a click on the Icon. 

 

¾ Thus, the Scan menu becomes available.  

 

  

 
¾ From the Scan Menu select Calibrate. 

 

  

 
¾ If the Reference Gas is already activated continue with Yes. 

 

¾ Otherwise, press No and refer to Chapter 3.1.2 to activate the Reference Gas. 
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3.1.4 SET CALIBRATION PARAMETERS 
 
NOTE: Depending on the IRMS type, the Start values, Stop values and Calibration 

Scans can be different. 
 

 

 

 

 
¾ For a first Scan, keep the default values. 

¾ Confirm by OK. 
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3.1.5 CALIBRATION SCAN 
 
 

 
 
¾ The Calibration Scan is finished. 

¾ Vertical lines appear (see the arrows) for assigning the correct position of the calibration

 masses. 

 

mass 
12 

mass 
28 

mass 
44 
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3.1.6 ASSIGN CALIBRATION MASSES 
 
 

  

 
¾ Assign the calibration masses to their peaks by drag&drop of the vertical lines 

 with your mouse, snapping the lines to the mass peaks. 

Alternative: 

¾ Click the Next Peak or Previous Peak Icon on the

 left toolbar to move the lines. 
  

 

mass 
12 

mass 
28 

mass 
44 
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¾ In the left window, the calibration masses of the Calibration Scan are now listed together

 with their corresponding BDAC-values and amplitudes. 

 

NOTE: Depending on the IRMS type and the calibration gases, the Calibration 
Scans are different. 

Calibration 
masses 
 
BDAC 
values 
 
and  
 
amplitudes 
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3.1.6.1 EXAMPLES FOR CALIBRATION SCANS 

 
 CO2 Calibration Scan on a Delta Plus XL 
  

 

 
¾ Assign the calibration masses to their peaks by drag & drop of the vertical lines using 

your mouse, snapping the lines to the mass peaks. 

 

 

CO2 

mass 
12 

mass 
28 

mass 
44 
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 SO2 Calibration Scan on a Delta Plus XL 
  

 

 
¾ Assign the calibration masses to their peaks by drag & drop of the vertical lines using 

your mouse, snapping the lines to the mass peaks. 

 

mass 
32 

mass 
48 

mass 
66 

SO2 
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3.1.7 FINISH CALIBRATION 
 
 
¾ From the toolbar on the left select the Finish Calibration Icon. 

 

¾ To finish Calibration, ISODAT NT jumps to the individual calibration 

masses and optimizes the BDAC value by a Peak Center procedure. 
 

 

  

 
 

a optimized BDAC-value for mass peak after Mass Calibration 

b mass peak by Magnet Scan 

a 

a 

a 

b 

b 

b 
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¾ The Calibration performed is optimized for jumping correctly at masses overcoming the 

magnet's hysteresis. 

In opposite to the previously performed Mass Scan, the correct BDAC-values 
always 

differ by several BDAC-steps to lower values, due to the magnet's hysteresis. 

BDAC-steps are transferred into masses (and vice versa). 
 
3.1.8 SAVE CALIBRATION 

When Calibration is finished, it must finally be saved. 

  

 
¾ Type a Calibration name and click Save. 

 

¾ Using Save As in the File menu, the Calibration Scan can be saved for documentation 

 only. 

 
 

 
Do not use old Calibration Scans for Recalibration! 

 



 
 

ISODAT NT           I N S T R U M E N T   C O N T R O L 3 
 
 

 
3 – 12 

 
     

 
Issue 06/2002 

3.2 BELLOW CALIBRATION 
 
Prior to a Dual Inlet Acquisition, a Bellow Calibration must be performed as follows: 

It is presumed, that the source has been switched on and focusing has been performed. 

 

¾ Start Instrument Control by double-clicking the Instrument Control Icon.       
 
¾ The Scan window appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

¾ Select your Configuration, e.g. Dual Inlet.                                
 

¾ Select your Gas Configuration, e.g. CO2.                                  
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NOTE: Activate the Dual Inlet System window by a click on its title bar! 

Thus, the title bar will turn from grey (i.e. inactive) to blue (i.e. active). 
Access to the Calibrate Menu won’t be possible while this window is inactive. 

 
¾ From the Calibrate Menu, select Bellows. 

Bellow Calibration must be performed in two steps: 
 
 
Step 1  Hardware Calibration of the bellows 
 
In Hardware Calibration, the bellows are opened as far as it will go (i.e. 100 %) and closed 
again (i.e. 0 %). 
 
 
 
 

¾ Enable the Hardware 
radio button. 

 
 
 
 
 

¾ Press OK. 
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¾ Press Yes to 
continue. 

 
 
NOTE: A Hardware Calibration deletes a Signal Calibration. Therefore, Hardware 

Calibration must always be performed prior to Signal Calibration! 

 
 
 
 

¾ The Hardware Calibration of the bellows has been 
finished. Press OK. 

 
 
 
 
Step 2 Signal Calibration of the bellows 
 
 
NOTE: Signal Calibration requires a signal intensity of at least 3 V! 
 
 
WARNING: If Signal Calibration has not been performed, the Diagnosis tests can’t be 

run! 
 
 

In Signal Calibration, the signal intensity is checked with partially filled bellows 

(at 25 % and at 75 %). Therefore, Signal Calibration must always be performed 

after Hardware Calibration. 

 
 
¾ Activate the Dual Inlet System window again by a click on its title bar. 

¾ Then, from the Calibrate Menu, select Bellows again. 
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Before starting Signal Calibration, an amount of gas must be let into the bellows, which 

results in a pressure of about 10 mbar - 20 mbar on each side. This gas amount is necessary 

to obtain a certain signal intensity. If the gas amount should be either too small 

(e.g.< 10 mbar) or too large, warning messages will occur. 

 

 
 
 
 
 
 
 

¾ Enable the Signal 
radio button. 

 
¾ Select Automatic and 

press OK. 
 
 
 
The signal intensity of the particular gas will be measured depending on the bellow volume. 
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4.1     GENERAL REMARKS 
 
4.1.1     PROCEDURE BEFORE STARTING ANY MEASUREMENTS 
 
NOTE: Before starting any acquisition make sure, the following procedure has 

been performed: 
 

1 Electronic offset has been measured and saved. 

2 All peripherals have been configured. 

3 The Mass Calibration for all gases to be measured has been performed. 

4 In case of a Dual Inlet application, the Bellow Calibration has been performed. 

5 In case of hydrogen collectors, the H3 factor for Continuous Flow and Dual Inlet 

application has been determined. 

6 In case of Elemental Analyzer application for C/N or H/O analysis, the Jump Cali- 

bration has been performed and saved. 

7 In case of a Liquid Autosampler, the COM port and the other parameters are set. 

 
NOTE: In case of any measurement, three steps must always be performed: 
 

1 Define a (Hardware-) Configuration 

2 Define a Method 

3 Define a Sequence 

 

These three basic steps will be described chronologically for several peripherals in this 

chapter. 
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4.1.2     IF NO CONFIGURATION IS AVAILABLE 
 

As first step, a Configuration containing the Dual Inlet System and your con-

nected peripheral(s) must exist. 

If no Configuration at all is available (e.g. you have either never before 

created one or you have just reset your IRMS), ISODAT NT requires some 

information about your hardware equipment first: 

 
 
 
 
 
 

¾ Your type of IRMS is required. 

 Select your Mass Spectrometer 

 (e.g. “Delta Plus XL”). 

 
 
 

¾ Press OK. 
 
 
 

¾ Check, whether the correct cups 
are installed. 

 

¾ Check, whether the correct cups 
are available for Peak Center. 

 

¾ Check, whether the resistor values 
are correct. 

 

¾ Confirm with OK. 
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¾ Check the available Gas Configurations. You can edit them by clicking on the fields 

(refer to the ISODAT NT Help System). 

 
¾ Finally, press Save & Close. 

 
 
You can now proceed creating a new Configuration using the Configurator. 
 

4.1.3     HOW TO CREATE A NEW GAS CONFIGURATION 

Prior to defining a new Gas Configuration ensure the connected IRMS has the cups set for 

the simultaneous detection of masses 44, 45 and 46 and mass calibration for these cups has 

already been performed. 

For a measurement, a new Gas Configuration has to be created for the masses 44 

(12C16O16O), 45 (13C16O16O) and 46 (12C16O 18O). 

 
 

¾ To create a new Gas Configuration, open the Dual Inlet module. 

 

¾ Then open the Gas Configuration Editor. 
 

¾ Add a Gas Configuration. 
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¾ Type CO2 for the Name. 
 

¾ Select Gas Configuration CO2 as Template. 
 

¾ Confirm with OK. 
 
 
 
 
 

¾ Select a Calibration 
valid for the selected 
cups. 

 
¾ Press Save & Close. 

 
 
 
The Dual Inlet application software allows fully automated isotope ratio determination of diffe-

rent elements of bulk samples (C, N, O, S). All parameters relevant for data acquisition of a 

sample are stored in a Method. Two different ways exist to get access to a Method or a 

Sequence: 

 

¾ Select a predefined Method and Sequence using the File Browser or 

¾ Create a new Method and Sequence on your own. 

 

Selecting a predefined Method and Sequence is the usual way described in detail for the 

different measurement types later in this chapter. The following information is needed, if you 

want to create a new Method or Sequence: 
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4.1.4     HOW TO CREATE A NEW METHOD 

 
¾ Open the Dual Inlet module. 

 
 

¾ Select the Configuration for your application 
(e.g. “Dual Inlet”). 

 
¾ Select the Gas Configuration (e.g. CO2). 

 
 

¾ Press the New button. 
 
 

¾ Press the Method Icon. 
 
 
The new Method is structured in Tab pages: Instrument, Peripherals, Evaluation, Printout and 

Dyn. Externals. Methods are described in detail later in this chapter. 

 

4.1.5     HOW TO CREATE A NEW SEQUENCE 

After having defined a new Method, a new Sequence can be created as follows: 

 
¾ Press the New button. 

 

 
 

¾ Press the Sequence Icon. 
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¾ Define the number of samples 

(e.g.: 3). 
 
 

 

 

¾ Edit the Sequence list. 

 
 
 

Peak Center Enable        to perform a Peak Center prior to measurement. 

Press Adjust Enable        to perform a pressure adjust. 

Background Enable        to perform a background measurement. 

 

Identifier 1 Edit text to identify sample. 

Method Select IRMS Method (for each sample, e.g. “CO2.met”). 

 
 

¾ Press the Start button. 
 
 

¾ Type a new significant File name 

retaining the extension .seq 

(e.g. “CO2.seq”). 

 
 
 
 

¾ Press Save. 
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¾ Define parameters for: 
 

� Results Export 

� Printout 

� Sequence Scripts 

 
 
 

¾ Press OK to start 
Sequence Acquisition. 
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4.2     ZERO ENRICHMENT (STANDARD ON / OFF TEST) 

We assume, that the user already has working experience with the Dual Inlet System, the 

Dual Inlet devices and with IRMS. It is recommended to perform a simple check in order to 

test the analytical condition of the complete system before measuring any samples. 

Proceed as follows for zero enrichment: 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods 

choose “CO2_zero.met” by 

double-click. 

 

 

 

 

NOTE: The Method “CO2_zero.met” for zero enrichment will be described here. 
It must be used, when both bellows are measured against each other. 

 
The Method “CO2_zero left.met” is used, when only the left bellow is measu-
red (against itself). 

 
The Method “CO2_zero right.met” is used, when only the right bellow is mea-
sured (against itself). 

 
The three Methods only differ from the Script. 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

one) are transferred to the Method. 
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¾ The Instrument tab of the 

Method “CO2_zero.met” 

appears. 

 

 

¾ For details see Chapter 4.3.2. 

 

 

 

NOTE: Ensure, that the proper peak center cup is selected. 
 If necessary, correct the default cup (e. g. Cup 4)! 

 

 

 

 

¾ At Peripherals tab, see 

Chapter 4.3.2 for details. 
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¾ At Evaluation CO2 tab, 

see Chapter 4.3.2 for details. 

 

¾ Select None or Sigma as 

Outlier test. 

In case of Sigma, specify 

the k-fold of the standard 

deviation using               . 

 

 

NOTE: At Std. Name, choose a suitable Standard! 
 

 

 

 

 

¾ At Printout tab, see Chapter 

4.3.2 for details. 
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4.3     SIMPLE DUAL INLET MEASUREMENT 
 
4.3.1     DEFINING A CONFIGURATION 
 
 

¾ Before operating, a Configuration containing the simple Dual Inlet System 

must be created in the Configurator as follows. 

 
 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 
 
 

¾ Give it a significant name, e.g. “Dual Inlet”. 
 
 
 

¾ Open the tree structure by a click on     at  
 
 
 
 

¾ On the right pane, 
 

select Dual Inlet. 
 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A      sign appears: 
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¾ The Dual Inlet device has been attached to the Source. 
 
 
 
 
 
 
 
 
 
 
 
 

¾ Close the Configurator window. 
 

All settings will be saved automatically. 
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4.3.2     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

¾ On the File Browser, select the Methods 

tab (default). 
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¾ From the predefined Methods choose a 

suitable one by double-click 

(e.g. “CO2.met”). 

 

 

 

 

 

 

¾ If the Standards in the Method to be opened 

are older than the actual ones in the Stan- 

dard Database, or if the user has changed 

the Method, the warning beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard Data- 

base (e.g. the laboratory Standard has changed or been replaced by another one) are 

transferred to the Method. 

 
Instrument 
 
¾ Select the Gas Configuration for 

your determination type (e.g. “CO2”). 

 
¾ The Main Script controls the acqui- 

sition cycle. 

 
NOTE: It should only be edited by 

users trained on script editing. 
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Isotope MS 

 
 
 
 
 
 
 
¾ Select the Peak Center Cup, e.g. Cup 4 for a universal triple collector on a 

DeltaPlus XP (narrow cup for m/z 45). 

 
¾ Peak Center Predelay is the time the system waits between activation of the refe- 

rence gas and start of the peak center cycle (e.g. 5 s). 

 
¾ Peak Center Postdelay is the time the system waits between the end of the peak 

center cycle and the start of the data acquisition (e.g. 0 s). 

 
¾ Integration time is the time integrated to form a data point triplet (e.g. 8 s). It is needed 

to measure each individual ion intensity of the masses 44, 45 and 46. 
 
Peripherals 

Dual Inlet System 

 

 

¾ Reference denotes, which bellow will contain the 
standard gas (default: right bellow). The other bel-
low will contain the sample. 

 
¾ Number of cycles indicates, how often a sample 

will be measured successively (e.g. 8 cycles 
means, that eight times the standard and eight 
times the sample is measured). 
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Pre-
Standard one cycle Mean of two Standards 

is compared to sample between. 

¾ A cycle is a series consisting of a standard measurement followed by a sample 

measurement. Thus, two standards flank every sample, one before it and one after it: 

 
 

St1     Sa1     St2     Sa2     St3     Sa3     St4     Sa4….. 
 
 
 
 
 
The first standard is called pre-standard (i.e. St1). The mean of two consecutive stan-dards is 
calculated and compared to the flanked sample (e.g. mean of St1 and St2 is compared to 
Sa1). 
 
¾ Idle time is the waiting time after having switched the changeover from sample to 

standard side (or vice versa) before the ion intensities of the masses 44, 45 

and 46 will be integrated. The gas needs a certain time to flow away, before 

the measurement can be started. 

 
¾ FV pump time is the time interval during which the Fore Vacuum pump will be active 

after it has started the pumping process (e.g. 10 s). 

 
¾ FV threshold is the pressure value that must be fallen below during Fore Vacuum pump 

activity (e.g. 0.03 mbar). If this value has been reached during FV pump 

time, the High Vacuum pump starts. If this value has not been reached, 

the system stops. 

 
¾ HV pump time is the time interval during which the High Vacuum pump is active after 

the FV threshold has been reached (e.g. 60 s). 
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Background 

 
¾ Background Predelay is the waiting time after 

closing the changeover valves until the back-

ground measurement begins. 

 
¾ Background Integration Cycles denotes, how 

long the background measurement will be perfor-

med (default: 1 cycle). k integration cycles specify 

that background measurement spans the k-fold 

integration time. 

 
Pressure Adjust 
If standard pressure and sample pressure are varying considerably, a pressure adjust will be 

necessary. It ensures that standard and sample are measured nearly at the same intensity. 

 

¾ on cup: cup on which the pressure adjust will be 

performed. Normally, it is the cup, where mass 44 

is measured. 

 
¾ Delay time is the waiting time after changing from 

sample to standard gas (or vice versa) before 

matching the standard bellow to sample ion 

intensity. 

 
¾ Tolerance denotes the precision of the pressure adjust. It is the maximally acceptable 

deviation of the ion intensities between the sample signal and the standard 

signal after matching. If the deviation is less than or equals the value (e.g. 

100 mV, this means ± 50 mV), the press adjust is finished successfully. 
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Bellow/Bellow 

 
 

¾ Master: the bellow that predefines the pressure, 

whereas the other bellow has to follow. Choose 

between “Left”, “Right” and “Manual”. 

 

In most cases, the sample bellow is defined as master. Thus, the sample enters the system 

with a certain predefined pressure p to which the standard will be compressed. 

 

NOTE: The standard bellow will be adjusted to the level of sample ion intensity minus 

signal up ± tolerance. 
 

 

¾ If you select “Manual”, you can edit the pressure 

level (intensity) that must be reached in both 

bellows. 

 
 
 
Capillary/Bellow 

 

¾ Signal up: match the ion intensity of the 

standard gas less than the given value before 

closing valve 25 and starting data acquisition. 
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Evaluation 

 
¾ Select an Ion Correction type 

(e.g. “CO2 Santrock et al.”). 

 
 

 

¾ Choose the type of Outlier Test. 
(Rejection criterion for possible out- 

liers: “None” or “Sigma”). 

 
� If you select None, only mean and standard deviation of the obtained delta values will 

be calculated. Outliers will not be identified. 

 
� If you select Sigma, those delta values beyond k times of the standard deviation will be 

identified and rejected. 

 

¾ If you selected Sigma, the button on 

the right side becomes available. 

Click it. 

 
 
 
 
 

¾ Select the k-fold standard deviation 

(default: k = 1). 
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¾ Extended Parameters: this function 

has not been implemented yet. Soon, 

you can choose an editable Script 

here, which contains the Ion Correc-

tion (i.e. type of Ion Correction and 

its location). 

 

¾ Std. Name: Select a Standard Name 

or edit the related delta values (user 

defined). 

 
The standards are predefined in the standard table. These values are isotope ratios of car-

bon and oxygen of your standard gas. 
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Printout 

Printout Templates 

 

¾ Single Print selects a print template 

from the Result Workshop for an in- 

dividual printout per sample. 

 
¾ Sequence Print selects a print temp- 

late from the Result Workshop for a 

reduced print per sample within a se- 

quence summary. 

 
WK1 Export Templates 
 
As with the above Printout Templates, WK1 Export Templates can be selected for an Excel-

Export of the data. 

 

¾ Single Print selects an Excel-Export 

Template from the Result Workshop 

for an individual printout per sample. 

 
¾ Sequence Print selects an Excel-

Export Template from the Result 

Workshop for a reduced print per 

sample within a sequence summary. 

Dyn. Externals: will follow soon. 

 
The Method for measurements using a simple Dual Inlet has now been established. As next 

step, either use a predefined Sequence (refer to Chapter 4.3.3) or create a new Sequence 

(refer to Chapter 4.1.5). 
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4.3.3     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab (default: Methods tab). 
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¾ From the predefined Sequences 

choose a suitable one by double-click 

(e.g.“CO2.seq”). 

 

 

 

 

 

 

 

¾ In the “Method” column, the Method 

chosen in Chapter 4.3.2 occurs as default 

(“CO2.met”). 

 

Normally, the Sequence List needs not to be edited further. It is possible, however, to select 

another Method from the “Method” column. 

 

 

¾ Press the Start button. 
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¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 
 

¾ Press OK to start Sequence Acquisition. 
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4.4     DUAL INLET MEASUREMENT INCLUDING MULTIPORT 
 
4.4.1     DEFINING A CONFIGURATION 
 
 

¾ Before operating, a Configuration containing the Dual Inlet System and 

the Multiport must be created in the Configurator as follows. 

 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 

 
 

¾ Give it a significant name, e.g. “Dual Inlet & Multiport”. 
 
 
 

¾ Open the tree structure by a click on       at 
 
 
 

¾ On the right pane, select 
 

 Dual Inlet + Multiport. 
 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A         sign appears: 
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¾ The Dual Inlet device has been attached to the Source. 
 
 
 
 

¾ The Multiport has been attached to the Intern Left Port. 
 
 
 
 
 
 

¾ Close the Configurator window. 

All settings will be saved automatically. 
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4.4.2     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods 

choose “CO2_multi.met” by double- 

click. 

 

 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

one) are transferred to the Method. 

 

¾ The Instrument tab of the 

Method “CO2_multi.met” 

appears. 

 

For details see Chapter 

4.3.2. 

 

 

 

NOTE: Ensure, that the proper peak center cup is selected. 
  If necessary, correct the default cup (i.e. Cup 4)! 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 30 

 
     

 
Issue 06/2002 

 

 

 

 

¾ See Chapter 4.3.2 for de- 

tails at Peripherals tab. 

 

 

 

 

 

 

NOTE: For measurements including Multiport two additional parameters occur: 
 

� Gas Transfer Time: time the sample gas needs to pass from the Multiport to 

the sample bellow (e.g. 60 s). The valves “bank”, “12”, 
“14” and “15” are opened. 

 

� Expansion Threshold: when the sample has entered its bellow, the sample 

gas pressure within it must not exceed the Expansion 

Threshold at bellow 100 % open (e.g. 70 mbar). If the 

pressure exceeds the threshold, sample gas will be 

pumped off stepwise in at the most 10 consecutive tri- 
als. If the pressure still exceeds the threshold after the- 
se trials, the system stops. In this case, use less subst- 
ance. 
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¾ At Evaluation CO2 tab, 

see Chapter 4.3.2 for details. 

 

¾ Select “None” or “Sigma” as 

Outlier test. In case of “Sigma”, 

specify the k-fold of the stan- 

dard deviation using         . 

 

NOTE: At Std. Name, choose a suitable Standard! 
 

 

 

¾ At Printout tab, see Chapter 

4.3.2 for details. 

 

 

 

 

 
The Method for measurements using Dual Inlet in combination with a Multiport has now been 

established. As next step, either use a predefined Sequence (refer to Chapter 4.4.3) or 

create a new Sequence (refer to Chapter 4.1.5). 
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4.4.3     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab 

(default: Methods tab). 
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¾ From the predefined Sequences 

choose “Multiport.seq” by double- 

click. 

 

 

 

 

 

 

 

 

¾ In the “Method” column, the Method 

chosen in Chapter 4.4.2 occurs as 

default (“CO2_Multi.met”). 

 

 

 

Normally, the Sequence List needs not to be edited further. It is possible, however, 

to select another Method from the “Method” column. 

 

NOTE: A new column, “Multiport Inlet”, occurs. It defines, which Multiport 
Inlet port will be connected to which sample (e.g. Inlet port 8 to 
Sample 8). It is possible to measure a sample repeatedly (e.g. 
connect both Sample 3 and Sample 4 to the Multiport Inlet port 3). 

 

¾ Press the Start button. 
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¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 
 

¾ Press OK to start 

Sequence Acquisition. 
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4.5     DUAL INLET MEASUREMENT INCLUDING MICROVOLUME 
 
4.5.1     MICROVOLUME - MEASUREMENT PRINCIPLE 
 
4.5.1.1     MICROVOLUME WITHOUT MULTIPORT - MEASUREMENT PRINCIPLE 
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4.5.1.2     MICROVOLUME VIA MULTIPORT - MEASUREMENT PRINCIPLE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Two fundamental measuring modes exist for using a Microvolume (via Multiport): 
 

¾ Expansion mode 
 

¾ Freeze direct mode 
 
 
4.5.1.3     EXPANSION MODE – GENERAL REMARKS 

Expansion mode is used, if the amount of gas to be measured is unknown. Depending on the 

unknown gas amount, the gas can be expanded into three different volumes: 

 
¾ Bank:     Volume between valves 11, 12, 13 and 14 

 
¾ Bank and Transferline:  Bank + volume between valve 12 and left val- 

ve of Microvolume 
 

¾ Bank, Transferline and Bellow: Bank + Transferline + Bellow, which is ope- 

ned to x % (i.e. Bellow Pos. [%]). 
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4.5.1.4     EXPANSION MODE – BEFORE MEASUREMENT 
 

1 Attach the sample to be measured to a sample valve (e.g. valve 1). 

2 Pump the volume between valve 1 and the sample valve. Close valve 1 and open 

sample valve. 

3 Ensure that on the Standard side enough gas is available. 

4 If Reference Refill is planned, activate         in the Sequence list. 

5 Start the Acquisition. 

6 After starting the Acquisition, the bellow of the Sample side (i.e. mostly left) will be 

opened fully, i.e. to 100 %. 

7 A first evacuation step by means of the fore vacuum pump takes places over the 

baseline (if after a certain time, which you can edit via a Script, the vacuum has not 

reached FV Threshold, the measurement will be canceled. An error message then ap-

pears). 

8 If FV Threshold has been reached, the fore vacuum pump continues to pump until FV 

Pump Time (e.g. 10 s) has elapsed. 

9 The bank valve, wasteline valve, left valve of Microvolume, right valve of Microvolume 

are opened as well as the valves 12, 13, 14, 15, 16 and 39. 

10 These opened valves are evacuated stepwise by means of the fore vacuum pump: 

first, only the bellow is evacuated. When FV Threshold has been reached in the 

bellow, the bank valve and then all other valves are evacuated one by one. To 

proceed evacuation, attainment of FV Threshold is required on every step: if FV 

Threshold is not reached on one of the steps, measurement will be canceled. An error 

message then appears. 
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11 A switch to High Vacuum is performed. A second evacuation step takes now place by 

means of the high vacuum pump until HV Pump Time has elapsed (e.g. 60 s). All 

valves are opened with the exception of valve 39. Valve 40 is set to “Toggle Switch”. 

ISODAT NT opens valve 39 while closing valve 40 and vice versa. 

12 Bank valve, wasteline valve, left valve of Microvolume, right valve of Microvolume are 

closed as well as valves 12, 13, 14, 16 and 40. Only valve 15 remains opened. 

13 The sample valve of the Multiport (e.g. valve 1) is opened. The system waits until 

Sample Equilibration Time has elapsed (e.g. 60 s). The pressure p is measured via 

the sensor. 

14 If you selected only Expansion mode (i.e. “Bank”), the sample gas will only be transfer-

red into the bank volume. 

If you selected “Bank and Transferline”, the bank valve must be opened additionally in 

order to transfer the sample gas into bank volume plus transferline. 

If you selected “Bank, Transferline and Bellow”, the bank valve, valve 12 and valve 14 

must be opened to transfer the sample gas throughout the whole system. 

15 The pressure p is determined using a pressure-meter (i.e. sensor). 

 

4.5.1.5     EXPANSION MODE – MEASUREMENT WITH BANK 

 

 

 

 

 

 

1 The pressure p is measured using a pressure-meter (i.e. sensor). 

2 If p > Freeze Bank Threshold (e.g. p > 6 mbar), the pressure is too high. 
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3 To reduce p, the gas in the bank volume has to be pumped off. Therefore, the sample 

valve, e.g. valve 1, is closed (all valves for the other samples, which currently are out 

of interest, are closed anyway). 

4 The gas in the bank volume is pumped off. 

5 The sample valve, e.g. valve 1, is opened (of course, all other sample valves remain 

closed). The sample gas expands into the bank volume. 

6 It is waited until Sample Equilibration Time has elapsed (e.g. 60 s). 

 

 

 

 

 

7 The pumping time depends on the three parameters 

 
¾ FV Threshold [mbar] 

¾ HV Pump Time [s] 

¾ FV Pump Time [s] 

 

 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 40 

 
     

 
Issue 06/2002 

8 After pumping the sample valve (e.g. valve 1) is opened. Again, the gas expands into 

the Bank volume. Again, it is waited, until the Sample Equilibration Time (e.g. 60 s) 

has elapsed. 

9 The decreased pressure p is measured again and compared to the Freeze Bank 

Threshold. 

 

Case 1: If Freeze All Threshold < p < Freeze Bank Threshold, the sample valve 

(e.g. valve 1) is closed. The transfer process of the sample into the 

Microvolume - which is explained elsewhere - starts. Measurement begins. 

 

 

 

 

 

 

Case 2: If p < Freeze All Threshold, only so few gas is available that it can be 

transferred immediately and measured as a whole (the sample valve, e.g. 

valve 1, will not be closed any longer). 

 

4.5.1.6     EXPANSION MODE – MEASUREMENT WITH BANK AND TRANSFERLINE 

 

 

 

 

 

The working principle is the same as described at “Expansion Mode - Bank”. Only the route 

of the sample gas is longer. 
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Example 
 

1 If Freeze All Threshold < p < Freeze Bank Threshold, the sample gas in the 

Transferline is pumped out to prevent Transferline gas from reaching the Microvolume. 

2 Only the sample gas in the Bank volume will be measured. 

 

4.5.1.7     EXPANSION MODE – MEASUREMENT WITH BANK, TRANSFERLINE AND 
BELLOW 

This expansion mode is used if large amounts of sample gas are available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 The bellow is opened to the specified percentage (e.g. 50 %). 

2 The sample valve (e.g. valve 1) is opened. 

3 Bank valve, valve 12 and valve 14 are opened. 

4 The sample gas is transferred up to the bellow (i.e. the whole volume is filled with 

gas). 

5 The pressure p is measured. 
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Case 1: If p > Bellow Direct Threshold, the sample is measured via the bellow. 

Case 2: If Freeze Bank Threshold < p < Bellow Direct Threshold, the sample 

valve (e.g. valve 1) is closed. The whole gas is pumped out. If nevertheless 

Freeze Bank Threshold < p < Bellow Direct Threshold is still valid, the pro-

cess will be repeated. 

Case 3: If Freeze All Threshold < p < Freeze Bank Threshold, Bank valve and 

sample valve (e.g. valve 1) are closed. After pumping off a part of the gas, 

only the gas in the bank volume will be frozen. 

Case 4: If p < Freeze All Threshold, only few gas is available. Therefore, the whole 

gas amount will be frozen. 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 43 

 
     

 
Issue 06/2002 

4.5.1.8     FREEZE DIRECT MODE 

Freeze direct mode is used 
 

¾ if the amount of sample gas to be analyzed is known 

¾ in case of very small gas samples 

 
The sample gas will not be expanded but transferred to the Microvolume directly. There, it 

will be frozen according to the parameter values and finally be measured. Therefore, note 

that the fields related to Expansion mode are inactive: 

 

 

 

 

 

 

 

 

 
 
 
 

1 The sample valve (e.g. valve 1) is opened. 

2 The gas in the bank volume is equilibrated until Sample Equilibration Time has elap-

sed. 

3 Simultaneously, the Microvolume is heated to Pump Out Temperature (e.g. 50 ºC). At 

this slightly elevated temperature, evaporation of impurities and water is facilitated. 

They are pumped off. Thus, the Microvolume is cleansed. 

4 The Microvolume is cooled down until Initial Transfer Temperature (e.g. - 50 ºC) is 

reached. 
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5 At Initial Transfer Temperature (e.g. -50 ºC), bank valve and left valve of Microvolume 

are opened. Thus, the sample gas is transferred to the Microvolume. 

6 The sample gas having just entered the Microvolume is cooled down further until 

Freeze Temperature (e.g. -175 ºC) is reached. 

7 The system waits, until Freeze Time has elapsed (e.g. 60 s). 

8 Then, bank valve and left valve of Microvolume are closed. 

9 The Microvolume is heated up to Measure Temperature (e.g. 50 ºC). 

10 The system waits until Delay Before Measure has elapsed. 

11 Measurement starts. 
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4.5.2     DEFINING A CONFIGURATION 
 
 

¾ Before operating, a Configuration containing the Dual Inlet System and 

the Microvolume must be created in the Configurator as follows. 

 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 

 
 

¾ Give it a significant name, e.g. “Dual Inlet & Micro-
volume”. 

 
 
 

¾ Open the tree structure by a click on     at 
 
 
 

¾ On the right pane, select 
 

“Dual Inlet + Micro- 
volume”. 

 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A       sign appears: 
 
 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 46 

 
     

 
Issue 06/2002 

 
¾ The Dual Inlet device has been attached to the Source. 

 
 
 
 
 

¾ The Microvolume has been attached to the Direct COV 

Port. 

 
 
 

¾ Close the Configurator window. 

All settings will be saved automatically. 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 47 

 
     

 
Issue 06/2002 

4.5.3     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods 

choose “Microvolume_only.met” 

by double-click. 

 

 

 

 

 

 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

one) are transferred to the Method. 
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¾ The Instrument tab of the 

Method “Microvolume_only.met” 

appears. 

 

¾ For details see Chapter 4.3.2. 

 

 

NOTE: Ensure, that the proper peak center cup is selected. 
  If necessary, correct the default cup (i.e. Cup 4)! 

 

 

 

¾ For details at the Peripherals 

tab’s Dual Inlet part see Chapter 

4.3.2. 

 

 

 

 

 

 

 

 

¾ For details about the Peripherals 

tab’s Microvolume part see 

Chapter 4.3.2. 

Peripherals tab: Dual Inlet part 

Peripherals tab: Microvolume part 
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¾ At Evaluation CO2 tab, 

select an Ion Correction type 

(e.g. “CO2 Santrock et al.”). 

 

¾ Select “None” or “Sigma” as 

Outlier test. In case of “Sigma”, 

specify the k-fold of the stan- 

dard deviation using         . 

 

For details see Chapter 4.3.2. 

 

NOTE: At Std. Name, choose a suitable Standard! 
 

 

¾ For details at the Printout tab, 

see Chapter 4.3.2. 

 

 

 

 

 

The Method for measurements using Dual Inlet in combination with a Microvolume has now 

been established. As next step, either use a predefined Sequence (refer to Chapter 4.5.4) 

or create a new Sequence (refer to Chapter 4.1.5). 
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4.5.4     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab 

(default: Methods tab). 
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¾ From the predefined Sequences 

choose “Microvolume_only.seq” 

by double-click. 

 

 

 

 
 
 

¾ In the “Method” column, the Method 

chosen in Chapter 4.5.3 occurs as 

default (“CO2_Multi.met”). 

 
 

Normally, the Sequence List needs not to be edited further. It is possible, however, 

to select another Method from the “Method” column. 

 
 
 

¾ Press the Start button. 
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¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 
 

¾ Press OK to start 

Sequence Acquisition. 
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4.6     DUAL INLET MEASUREMENT INCLUDING MULTIPORT AND MICROVOLUME 
 
4.6.1     DEFINING A CONFIGURATION 
 
 

¾ Before operating, a Configuration containing the Dual Inlet System, the 

Multiport and the Microvolume must be created in the Configurator as 

follows. 

 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 

 
 

¾ Give it a significant name, e.g. “Dual Inlet & Multiport & 
Microvolume”. 

 
 
 

¾ Open the tree structure by a click on     at 
 
 
 

¾ On the right pane, select 
 

Dual Inlet +Multiport + 
 

Microvolume. 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A       sign appears: 
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¾ The Dual Inlet device has been attached to the Source. 
 
 
 
 

¾ The Multiport has been attached to the Intern Left Port. 

 
 
 
 
 
 
 
 

 

 

 

 

¾ The Microvolume has been attached to the Direct COV 

Port. 

 
 

¾ Close the Configurator window. 

All settings will be saved automatically. 
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4.6.2     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods choo- 

se “Multiport + Microvolume.met” 

by double-click. 

 

 

 

 

 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

one) are transferred to the Method. 
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Peripherals tab: Dual Inlet part 

Peripherals tab: Microvolume part 

 

 

 

¾ The Instrument tab of the 

Method “Multiport + Microvolu- 

me.met” appears. 

 

¾ For details see Chapter 4.3.2. 

 

 

NOTE: Ensure, that the proper peak center cup is selected. 
  If necessary, correct the default cup! 

 

 

 

¾ For details at the Peripherals 

tab’s Dual Inlet part, see 

Chapter 4.3.2. 

 

 

 

 

 

 

¾ For details at the Peripherals 

tab’s Microvolume part, 

see Chapter 4.5.3. 
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¾ For details at the Peripherals 

tab’s Multiport part, see 

Chapter 4.4.2. 

 
¾ At Evaluation CO2 tab, 

Select an Ion Correct type, 

e.g. “CO2 Santrock et al.”. 

 

¾ Select “None” or “Sigma” as 

Outlier test. In case of “Sigma”, 

specify the k-fold of the stan- 

dard deviation using         . 

 

For details see Chapter 4.3.2. 

 

NOTE: At Std. Name, choose a suitable Standard! 
 

 

¾ For details at Printout tab, 

see Chapter 4.3.2. 

 

 

The Method for measurements using Dual Inlet in combination with a Multiport and a Micro-

volume has now been established. As next step, either use a predefined Sequence (refer to 

Chapter 4.6.3) or create a new Sequence (refer to Chapter 4.1.5). 

Peripherals tab: 
Multiport part 
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4.6.3     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab 

(default: Methods tab). 
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¾ From the predefined Sequences 

choose “Multiport + Microvolu- 
me.seq” by double-click. 

 

 

 

 

 

 
 

¾ In the “Method” column, the Method 

chosen in Chapter 4.6.2 occurs as 

default 

(“Multiport + Microvolume.met”). 

 

 
 

Normally, the Sequence List needs not to be edited further. It is possible, however, 

e.g. to select another Method from the “Method” column or to modify the “Multiport 

Inlet” column. For details, see Chapter 4.3.3. 

 
 

¾ Press the Start button. 
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¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 
 
 
 

¾ Press OK to start 

Sequence Acquisition. 
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4.7     DUAL INLET MEASUREMENT INCLUDING MULTIPORT AND REFERENCE 
REFILL 

 
4.7.1     DEFINING A CONFIGURATION 

 
 

¾ Before operating, a Configuration containing the Dual Inlet System, 

Multiport and Reference Refill must be created in the Configurator as 

follows. 

 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 

¾ Give it a significant name, e.g. “Dual Inlet & Multiport & 
Reference Refill”. 

 
 
 

¾ Open the tree structure by a click on     at 
 
 
 
 
 

¾ On the right pane, select 
 

Dual Inlet + Multiport +  
Reference Refill. 

 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A       sign appears: 
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¾ The Dual Inlet device has been attached to the Source. 

 
 
 

¾ The Reference Refill device has been attached to the 

Intern Right Port. 

It is always connected to the right side (i.e. the Standard 

side) - internal or external. 

 
¾ The Multiport has been attached to the Intern Left Port. 

 

¾ Close the Configurator window. 

All settings will be saved automatically. 
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4.7.2     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods choo- 

se a suitable Method (e.g. “Multi- 
port + Reference Refill.met”) by 

double-click. 

 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

Standard) are transferred to the Method. 

 

Instrument tab 
 
The Instrument tab of the Method “Multiport + Reference Refill.met” appears. 
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¾ As Gasconfiguration select “CO2”. 

¾ The Main Script controls the acquisition cycle. 

NOTE: It should only be edited by users trained on script editing. 
 

 

 

 

¾ Integration time:   The time needed to measure each individual ion 

   intensity of the masses 44, 45 and 46. 

¾ Select the Peak Center Cup (e.g. Cup 3). 

¾ Peak Center Pre Delay: Waiting time between activation of reference gas 

and start of peak center cycle (e.g. 60 s). 

¾ Peak Center Post Delay: Waiting time between end of peak center cycle and 

start of data acquisition. 

 

 

 

 

 
 

NOTE: The above information is specific for Reference Refill applications. 
  The values depend - among others - on the diameter of the Reference 

  Refill capillary. 
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¾ Pump Overlay Time: Capillary pump out time of Reference Refill tank. 

¾ FV Threshold:  Minimum pressure of standard bellow including the valves 

  and tubes evacuated using fore vacuum pump before con- 

  tinuing pumping using turbo molecular pump. 

¾ Refill Time: Gas flow time from Reference Refill tank into inlet port of 

 standard bellow. 

¾ HV Pump Time: Pumping time of bellow including the valves and tubes 

 using turbo molecular pump. 

 
Peripherals tab 

 

 

 

 

 

 

 

 

 
For details see Chapter 4.3.2. 

 
 

 

 

For details see Chapter 4.3.2. 

 
 

 

For details see Chapter 4.3.2. 
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Evaluation tab 

 

 

 

 

 

 

¾ Select the Ion Correction Type (e.g. “CO2 Santrock et al.”). 

 

 

 

 

 

¾ As Outlier test select “None” or “Sigma”. In case of “Sigma”, specify the k-fold of 

the standard deviation using         . For details see Chapter 4.3.2. 

 

 

 

 

 

 

 
 
 
 
 
 

¾ At Std. Name, choose a suitable Standard. 
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Printout tab 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

The Method for measurements using Dual Inlet in combination with a Multiport and a 

Reference Refill has now been established. As next step, either use a predefined Sequence 
(refer to Chapter 4.7.3) or create a new Sequence (refer to Chapter 4.1.5). 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 71 

 
     

 
Issue 06/2002 

4.7.3     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab 

(default: Methods tab). 
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¾ From the predefined Sequences 

choose “Multiport + Reference 

Refill.seq” by double-click. 

 

 

 

 

 

 

 

 

 

 

 

 

 

¾ In the Method column, the Method chosen in Chapter 4.7.2 occurs as default 

(“Multiport + Reference Refill.met”). 

¾ Normally, the Sequence List needs not to be edited further. It is possible, however, 

e.g. to select another Method from the “Method” column or to modify the “Multiport 

Inlet” column. 

¾ The Multiport Inlet column defines the Multiport Inlet Port from which a particular 

sample is taken (e.g. Sample 2 enters via Multiport Inlet Port 2). 

If enough sample is available, it is possible to measure repeatedly out of the same 

port. 
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¾ If a Reference Refill is to be performed, the          column must be activated by       

for the particular sample (e.g. for Sample 1). 

 

¾ Press the Start button. 

 
 
 
 
 
 
 
 
 

¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 

¾ Press OK to start 

Sequence Acquisition. 
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4.8     DUAL INLET MEASUREMENT INCLUDING MULTIPORT AND BUFFERED REFILL 

 
4.8.1     DEFINING A CONFIGURATION 

 
 

¾ Before operating, a Configuration containing the Dual Inlet System, Multi-

port and Buffered Refill must be created in the Configurator as follows. 

 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 

 
 

¾ Give it a significant name, e.g. “Dual Inlet & Multiport & 
Buffered Refill”. 

 
 
 

¾ Open the tree structure by a click on     at 
 
 
 

¾ On the right pane, select 
 

Dual Inlet + Multi- 
port + Buffered Refill. 

 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A       sign appears: 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 75 

 
     

 
Issue 06/2002 

 
 

¾ The Dual Inlet device has been attached to the Source. 
 
 
 
 

¾ The Buffered Refill device has been attached to the 

Intern Right Port. 

 
¾ The Multiport device has been attached to the Intern Left 

Port. 

 
¾ Close the Configurator window. 

All settings will be saved automatically. 
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4.8.2     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods choo- 

se a suitable Method (e.g. “Multi- 
port + Buffered Refill.met”) by 

double-click. 

 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

Standard) are transferred to the Method. 

 

Instrument tab 
 
The Instrument tab of the Method “Multiport + Buffered Refill.met” appears. 
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¾ As Gasconfiguration select “CO2”. 

¾ The Main Script controls the acquisition cycle. 

NOTE: It should only be edited by users trained on script editing. 

 

 

 

 

¾ Integration time:  The time needed to measure each individual ion inten- 

  sity of the masses 44, 45 and 46 (e.g. 8 s). 

 

¾ Peak Center Cup:  Select the Peak Center Cup (e.g. Cup 3). 
 

¾ Peak Center Pre Delay: Waiting time between activation of reference gas and 

   start of peak center cycle (e.g. 60 s). 
 

¾ Peak Center Post Delay: Waiting time between end of peak center cycle and 

   start of data acquisition (e.g. 60 s). 

 

 

 

 

 

NOTE: The above information is specific for Buffered Refill applications. 
 

¾ Refill Time: Gas flow time from Buffered Refill tank into inlet port of 

  standard bellow (e.g. 10 ms). 
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Peripherals tab 

 

 

 

 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

 

 

 

For details see Chapter 4.3.2. 

 

 

 

 
For details see Chapter 4.3.2. 

 
Evaluation tab 

 

 

 

 

 

¾ Select the Ion Correction Type (e.g. “CO2 Santrock et al.”). 
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¾ As Outlier test select “None” or “Sigma”. In case of “Sigma”, specify the k-fold of 

the standard deviation using         . 

 

 

 

 

 

 

 

 

 

 
 
 

¾ At Std. Name, choose a suitable Standard. 
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Printout tab 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

The Method for measurements using Dual Inlet in combination with a Multiport and a Buffe-

red Refill has now been established. As next step, either use a predefined Sequence (refer 

to Chapter 4.8.3) or create a new Sequence (refer to Chapter 4.1.5). 
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4.8.3     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab 

(default: Methods tab). 
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¾ From the predefined Sequences 

choose Multiport + Buffered 

Refill.seq by double-click. 

 

 

 

 

 

 

 

 

 

 

 

 

 

¾ In the Method column, the Method chosen in Chapter 4.8.2 occurs as default 

(“Multiport + Buffered Refill.met”). 

¾ Normally, the Sequence List needs not to be edited further. It is possible, however, 

e.g. to select another Method from the “Method” column or to modify the “Multiport 

Inlet” column. 

¾ The Multiport Inlet column defines the Multiport Inlet Port from which a particular 

sample is taken (e.g. Sample 2 enters via Multiport Inlet Port 2). 

If enough sample is available, it is possible to measure repeatedly out of the same 

port. 



 
 

ISODAT NT          D U A L   I N L E T   M E A S U R E M E N T S 4 
 
 

 
4 – 84 

 
     

 
Issue 06/2002 

¾ If a Buffered Refill is to be performed, the          column must be activated by       

for the particular sample (e.g. for Sample 1). 

 

¾ Press the Start button. 

 
 
 
 
 
 
 
 
 

¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 

¾ Press OK to start 

Sequence Acquisition. 
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4.9    DUAL INLET MEASUREMENT INCLUDING H-DEVICE AND AUTOSAMPLER A200S 

 
4.9.1     DEFINING A CONFIGURATION 

 
 

¾ Before operating, a Configuration containing the Dual Inlet System, H-

Device and Autosampler must be created in the Configurator as follows. 

 
 

¾ Add a new Configuration using the Add Configuration button. 

 
 

 
 

¾ Give it a significant name, e.g. “Dual Inlet & HDevice & 
Autosampler”. 

 
 
 

¾ Open the tree structure by a click on     at 
 
 
 

¾ On the right pane, select 
 

Dual Inlet + HDevice + 
A200S Sampler. 

 
 
 
 

¾ Drag it to the Source port  of the new Configuration. 
 

A       sign appears: 
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¾ The Dual Inlet device has been attached to the Source. 

 
 
 
 

¾ The H-Device has been attached to the Extern Left Port. 

 

¾ The A200S Autosampler has been attached to the Samp-
ler Port. 

 

¾ Close the Configurator window. 

All settings will be saved automatically. 
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4.9.2     USING A PREDEFINED METHOD 

 

¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Methods tab (default). 
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¾ From the predefined Methods choo- 

se a suitable Method 

(e.g. “H_Device + A200S.met”) by 

double-click. 

 

 

 

 

¾ If the Standards in the Method to be 

opened are older than the actual ones 

in the Standard Database, or if the user 

has changed the Method, the warning 

beside appears. 

 

¾ Press OK. Thus, the Method will be corrected: the actual values of the Standard 

Database (e.g. the laboratory Standard has changed or been replaced by another 

Standard) are transferred to the Method. 

 

Instrument tab 
 
The Instrument tab of the Method “H_Device + A200S.met” appears. 
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¾ As Gasconfiguration select “CO2”. 

¾ The Main Script controls the acquisition cycle. 

NOTE: It should only be edited by users trained on script editing. 
 

 

 

 

¾ Integration time: The time needed to measure each individual ion inten- 

 sity of the masses 44, 45 and 46 (e.g. 8 s). 

¾ Peak Center Cup :   Select the Cup for peak center (e.g. Cup 3). 

¾ Peak Center Pre Delay: Waiting time between activation of reference gas and 

   start of peak center cycle (e.g. 60 s). 

¾ Peak Center Post Delay: Waiting time between end of peak center cycle and 

 start of data acquisition (e.g. 60 s). 

 
Peripherals tab 

 

 

 

 

 

 

 

 

 
For details see Chapter 4.3.2. 
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For details see Chapter 4.3.2. 

 

 

 

 

 

NOTE: The above information is specific for H-Device applications. 
 

¾ Reaction Time:  Time for the injected substance to react with chromium 

(e.g. 60 s). Reaction time differs between substances. 

Water only needs 20 to 60 s to react, whereas organic 

compounds need longer times, which must be determined 

empirically. 

NOTE: Valve 11 must be closed! 
 

¾ Transfer Time:  Time for the gas to expand from the expansion volume into 

the bellow (e.g. 60 s). 

¾ Equilibration Time: Valve 11 is opened and the gas mixture is allowed to ex- 

pand into the intermediate or expansion volume (connec- 

ting metal hose plus valve body). An equilibration time of 

30 s is recommended for 800 ºC to 850 ºC. For other tem- 

peratures, this needs to be tested empirically. 
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Evaluation tab 

 

 

 

 

 

 

¾ Select the Ion Correction Type (e.g. “CO2 Santrock et al.”). 

 

 

 

 

 

¾ As Outlier test select “None” or “Sigma”. In case of “Sigma”, specify the k-fold of 

the standard deviation using         . 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

 

 

 

 
¾ At Std. Name, choose a suitable Standard. 
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Printout tab 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

 

 

 

 

For details see Chapter 4.3.2. 

 

The Method for measurements using Dual Inlet in combination with a H-Device and an 

A200S Autosampler has now been established. As next step, either use a predefined 
Sequence (refer to Chapter 4.9.3) or create a new Sequence (refer to Chapter 4.1.5). 
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4.9.3     USING A PREDEFINED SEQUENCE 

 
¾ If the File Browser cannot be seen, press the Options button. 

 

 

 

 

 

 

¾ Activate the File Browser check box. 

 

 

 

 

¾ Click OK. 

 

 

 

 

 

 

¾ On the File Browser, select the 

Sequences tab 

(default: Methods tab). 
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¾ From the predefined Sequences 

choose a suitable one 

(e.g. H_Device + A200S.seq) 

by double-click. 

 

 

 

 

 

 

 

 

 

 

 

¾ Normally, the Sequence List needs not to be edited further. It is possible, however, 

e.g. to select another Method from the “Method” pulldown menu. 

 
¾ AS Sample: Type in the sample position in the Autosampler tray. 

¾ AS Method: Select Autosampler Method. 

¾ Identifier 1: Edit text to identify the sample. 

¾ Method:  Select IRMS Method. The Method chosen in Chapter 4.9.2 occurs 

  as default (“H_Device + A200S.met”). 
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¾ Press the Start button. 

 
 
 
 
 
 
 

¾ Define parameters for: 

 
� Results Export 
� Printout 
� Sequence Scripts 

 
 

¾ Press OK to start 

Sequence Acquisition. 
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OPERATING MANUAL 
 
 
 
 
 
 
 
 
 
 
 

CONTINUOUS FLOW MEASUREMENTS 
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5.1 OXYGEN MEASUREMENT 
 
5.1.1 DEFINING A GAS CONFIGURATION 

Prior to defining this Gas Configuration ensure the connected IRMS has the cups set for the 
simultaneous detection of masses 28, 29 and 30 and Mass Calibration for these cups has 
already been performed. 
 
For an 18O measurement, a new Gasconfiguration has to be created for the masses 28 
(12C16O), 29 (13C16O) and 30 (12C18O). 
 

¾ Open the Continuous Flow module. 
 

¾ Open the Gas Configuration Editor. 
 

¾ Add a Gas Configuration. 
 
 
 
 

¾ Select Gas Configuration N2 as Template. 
 

¾ Type CO for the Name. 
 

¾ Confirm by OK. 
 
 

¾ Select a Calibration 
valid for the selected 
cups. 

 
¾ Change the Formula 

from N2 to CO. 
 

¾ Press Save & Close. 
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5.1.2 DEFINING A CONFIGURATION 
 

Before operating, a Configuration must be created in the Configurator. 
 
 

¾ Add a new Configuration with the “Add Configuration” button. 
 

¾ Give it a name, e.g. “ConFlo II & TC / EA”. 
 
 

 
 
 
 
 
 

 
¾ Select e.g. one of the “ConFlo II Sets” (also for 

ConFlo III) and drag it to the Source port  or 
Capillary port  in the new Configuration. 

 
¾ Open the complete tree structure of e.g. the 

ConFlo II Interface to check for the attached 
hardware. 

 
 
 
 

¾ Activate the Advanced Mode in the Edit menu. 
 

¾ Click with the right mouse button on the 
Communication Hardware object to open the 
Properties window. 

 
 

¾ Close the Configurator window. All settings will be saved automatically. 
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5.1.3 DEFINING A NEW METHOD 
 
The Continuous Flow application software allows fully automated isotope ratio determination 
of oxygen of bulk samples. All parameters relevant for data acquisition of a sample are stored 
in a Method. The following steps are needed to define a new Method. 
 

¾ Open the Continuous Flow module. 
 

¾ Select the Configuration (e.g. “ConFlo II & TC/EA”). 
 

¾ Select the Gas Configuration for 18O determination. 
 

¾ Create a new Method. 
 
The new Method is structured in Tab pages: Instrument, Time Events, Evaluation, Peak 
Detection, and Printout. The following Method explains the parameters of an 18O Method. 
 
Instrument 

¾ Select Gas Configuration for 18O determina- 
tion (e.g. “CO”). 

 
¾ Main Script controls the acquisition cycle. 

 
NOTE:   It should only be edited by users trained 
    on script editing. 

 
¾ Select the Peak Center Cup, e.g. Cup 3 for a 

triple collector on a DeltaPlus XL (narrow 
center cup for m/z 29). 

 
¾ Peak Center Predelay is the time the system 

waits between activation of the reference gas 
and start of the peak center cycle 
(e.g. > 15 s). 

 
¾ Peak Center Postdelay is the time the system waits between the end of the peak 

center cycle and the start of the data acquisition (e.g. 0 s). 
 

¾ Integration time is the time integrated to form a data point triplet (e.g. 0.25 s). 
 

¾ Select the Reference Port to be used for peak center (e.g. Reference 1). 
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Time Events 
 

The “Time Events” list controls all valves of the 
selected Configuration during data acquisition. 

 
¾ Insert lines using right mouse button or click 

on . 
 

¾ Edit the Time at which the event will happen and 
double-click the field of a valve to set or toggle its 
status to active  or inactive . 

 
¾ Edit the Acquisition Time. The acquisition time is 

the end time of data acquisition. After the acquisi-
tion time, no further actions will be executed from 
the time events list. 

Evaluation 
¾ Select an Ion Correction Type 

(e.g. “CO Santrock et al.”). 
 

¾ Add a standard using the right mouse button. 
Enter the retention time of the standard peak(s) 
defined in "Time Events" which are used for cal-
culating the corresponding delta value(s). 

 

If the assigned time for Standard peak detection 
falls in between the Peak Start and Peak Stop 
marks of a peak, this peak will be used for delta 
value calculation. 

 
¾ Select a Std. Name or edit the related delta 

values (user defined). 
 

¾ Reference / Blank: For a blank determination, a 
time window needs to be defined by significant 
peak start and stop in which the corresponding 
CO peak will appear. 

 
 

¾ For weight percent determination type in the 
appropriate oxygen weight percent of the 
reference compound used for Calibration. 

The retention time must be set to 
the “Reference Out” value of the 
second CO Reference Gas pulse 
(in “Time Events”). This accommo-
dates for the delay associated with 
the gas passage through the capil-
lary to the IRMS. 
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Peak Detection 
 

¾ Edit Start Slope, End Slope, and Peak Min. 
Height. All other parameters can be kept 
default. 

 
¾ A five point average slope of 0.2 mV/s (Start 

Slope) and of 0.4 mV/s (End Slope) is recom-
mended for safe recognition of the peak 
boundaries. The best slope values depend on 
the nature of the chromatogram. 

 
 

¾ Peak Min. Height limits the number of 
reported peaks. Default is 50 mV. 

 
¾ Individual BGD is the default Background 

Type. 
 
Printout 
 

¾ Single Print selects a print template from the 
Result Workshop for an individual printout per 
sample. 

 
¾ Sequence Print selects a print template from 

the Result Workshop for a reduced print per 
sample within a sequence summary. 
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5.1.4 ZERO ENRICHMENT (ST ON / OFF TEST) 
 
We assume that the user already has working experience with the complete system. It is 
recommended to perform a simple check in order to test its analytical condition before mea-
suring any samples. 
 

1 Use the following default Method (“CO_zero.met”) as a guideline. 
 

Instrument 
 
 
 
 
 
 
 

Isotope MS 
 
 
 

Time Events 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Acq. End Time 
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Evaluation 
 
 
 
 
 
 
 
 

Peak Detection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Printout 
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2 Set the ion intensity of mass 28 (12C16O) to approximately 3 – 4 V by opening 

Reference 1 and adjusting the pressure to the desired intensity. 

 
3 Create a new Sequence or 

select a predefined Sequence from the File Browser. 

 
 
 
 
 
 

4 Press the Start button. 
 
 
 
 
 
 
 
 
 

5 Select your destination folder. 
 
 

Make your Printout decision (Yes / No). 
 
 

Finally, confirm by OK. 
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5.1.5 SOLID-AUTOSAMPLER LEAK TEST 
 
While monitoring mass 28, start the solid-autosampler manually. The intensity of mass 28 
should not increase more than 20 mV. If the measured value is 1.5 times higher than expec-
ted, increase the He purge and repeat the test. 
 
NOTE:   a) Neither Reference 1 nor Reference 2 nor He dilution should be open during the 

test. 
 

b) To activate the solid-autosampler manually, switch the symbol to the position 
“Start” by a mouse click. 
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5.1.6 HOW TO START AN OXYGEN MEASUREMENT 
 

1 Define a Method 
 
 

Instrument 
 
 
 
 
 
 
 

Isotope MS 
 
 
 
 
 
 
 
 

Time Events 
 
 
 
 
 
 
 
 
 
 
 

Acq. End Time 
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Evaluation 

 
 
 
 
 
 
 
 
 
 
 
 

Peak Detection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Printout 
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3 Place a sample (e.g. 0.285 mg of benzoic acid) in the solid-autosampler. 

 
 

4 Create a new Sequence.  

 
 
 
 

5 Define the number of samples (e.g. 3). 

 
 
 
 
 

6 Edit the Sequence list. 

 
 
 
 
 
 

Peak Center Enable        to perform a Peak Center prior to measurement. 

Identifier 1 Edit text to identify sample. 

Method  Select IRMS Method. 

 
 

7 Press the Start button. 
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8 Define Results Export 

and Printout parameters. 
 
 
 
 
 
 
 
 
 
 

9 Press OK to start 
Sequence Acquisition. 

 
 
 

Events during Acquisition 
 

¾ Peak Center procedure 
 

¾ First CO Reference Gas pulse activated at 20 s (duration: 20 s). 
 

¾ Second CO Reference Gas pulse activated at 70 s (duration: 20 s). 
It is assigned as Standard pulse for delta value calculation. 
Refer to “Time” column in “Evaluation” tab. 

 
¾ Sample is dropped into reactor. 

 
¾ Sample peak appears approximately 100 s after start of reaction. 

 
¾ Third CO Reference Gas pulse activated at 360 s (duration: 20 s). 

 
¾ Forth CO Reference Gas pulse activated at 400 s (duration 20 s). 

 
¾ Acquisition stops at 450 s. 
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After finishing data acquisition the printer creates a data output sheet as defined by the selec-

ted Results Workshop template (*.irw). The Results are also exported to a spreadsheet file. 
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5.1.7 WEIGHT PERCENT DETERMINATION - GENERAL 
 

1 Identification of the significant peak’s position 
 
 
In the Method’s Evaluation tab a weight percent determination can be chosen for the 
significant Peak of References. It cannot be performed in case of Blanks. 
 
All calculations of weight percent determination refer to the so called significant Peak. To 
first and foremost determine its position, in the Method’s Evaluation tab an interval must be 
defined by a Significant Peak Start value and a Significant Peak Stop value. 
 
Since this interval will not automatically be identified, a sample chromatogram must be 
recorded which reveals the position of the significant Peak. Consider that the position can 
vary slightly over time due to alteration processes (e.g. of glassy carbon). Dimensioning the 
interval sufficiently broad will prevent the significant peak from falling or migrating outside it. 
 
 

2 Calculation of weight percent 
 
 
Weight percent determination bases upon the relationships between peak area of the 
significant peak and sample weight. 
 
First, a Reference (i.e. a well-known substance; not necessarily identical to the compound of 
the later sample) is measured to obtain the k-Factor k according to the formula: 
 

ref

refref

A
mw

k
*

=  

 
The Reference’s weight percent wref and mass mref are given whereas its peak area Aref 
emerges from the measurement. Possibly, Aref can be used blank-corrected to enhance the 
precision of k-Factor calculation. 
 
Using the k-Factor just calculated, now the sample itself can be measured. Its peak area 
Asample results (possibly blank-corrected), whereas sample weight msample and k-Factor k are 
well known, so that the parameter of interest, the sample’s weight percentage wsample, can be 
easily obtained rearranging the above equation: 
 

sample

sample
sample m

Ak
w

*
=  
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5.1.8 WEIGHT PERCENT DETERMINATION - PROCEDURE FOR OXYGEN 
 
The system requires a Calibration procedure in order to cal-culate the amount of oxygen in 
the sample. 
 
 

1 Weigh a reference compound, e.g. 0.285 mg of benzoic acid, in a silver capsule 
and wrap it carefully. 

 
NOTE: The precision of weighing is directly related to the precision of weight 

percent determination. 
 
 

2 Place the capsule in the solid-autosampler. 
 
 

3 Method (Evaluation tab) 
 
 
 
 
 
 
 

4 Sequence 
 
 
 
 

The Method “CO-only.met” is described in detail in Chapter 5.1.3. 
 
 

5 Start the Sequence. 
 
 
NOTE: In order to obtain reasonable results, this Calibration has to be performed daily 

and after changing any parameters of the system. 
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5.1.9 BLANK MEASUREMENT - GENERAL 
 
Blank value determination can help to enhance precision. The resulting blank value is then 
subtracted from both reference and sample peaks. Thus, the chronological order to proceed 
normally is: 1. Blank, 2. Reference, 3. Sample. 
 
Blank and Reference values are stored in separate databases. A further criterion of separate 
storage is the gas name. To measure samples directly, i.e. without Blank and Reference 
before, delete these databases via Quant Menu. 
 
In the following, the different commands for Blank measurement will be explained. 
 

Blank command 
 

 

 
¾ From the Type Menu 

select Blank. 

 
 
 
The previous Blank value will be deleted. Instead, the result of this current Blank measure-

ment will be enlisted as new Blank value. 

 
Start Blank Mean command 

 
 

 

¾ From the Type Menu 

select Start Blank 

Mean. 

 

The previous Blank value will be deleted. Instead, the result of this current Blank measure-

ment will be enlisted as new Blank value. Further Blanks can be added to be taken into 

account determining the Blank Mean. 
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Add Blank Mean command 

 

 

 

¾ From the Type Menu 

select Add Blank Mean. 

 

 

The old Blank Mean will be corrected using the new Blank value to yield the new Blank Mean 

according to the formula: 

1
*

'
+

+
=

b

bb
b n

bnm
m  

where:  

 

 

 

 

 
 

 

 

 

 

 

 

mb’     new Blank Mean 
mb      old Blank Mean 
nb       number of previously measured Blank values (since Blank Start) 
b        new Blank value 
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5.1.10 BLANK MEASUREMENT - PROCEDURE FOR OXYGEN 
 

The tiny blank signal must be detected in the window. 
 

1 Place an empty silver capsule into the solid-autosampler. 
 
 

2 Method (Evaluation tab) 
 
 
 
 
 
 
 
 

3 Sequence 
 
 
 
 

The Method “CO-only.met” is described in detail in Chapter 5.1.3. 
 
 

4 Start the Sequence. 
 
 
 
NOTE: In order to obtain reasonable results, this Calibration has to be performed daily 

and after changing any parameters of the system. 
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5.1.11 REFERENCE MEASUREMENT - GENERAL 
 
Three procedures (i.e. commands) exist to perform Reference measurements: 
 

¾ Reference 

¾ Start Reference Mean 

¾ Start Reference Regression 

 

Reference command 
 
 
 

 

¾ From the Type Menu 

select Reference. 

 
 
The previous Reference value will be deleted. Instead, the result of this current Reference 

measurement will be enlisted as new Reference value. 

 
 

Start Reference Mean command 
 
 
 
 
 

¾ From the Type Menu 

select Start Reference 

Mean. 

 
The previous Reference value will be deleted. Instead, the result of this current Reference 

measurement will be enlisted as new Reference value. Further References can be added to 

be taken into account determining the Reference Mean. 
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Add Reference Mean command 

 
 
 
 

¾ From the Type Menu 
select Add Reference 
Mean. 

 

 
 
 
The old Reference Mean will be corrected using the new Reference value to yield the new 
Reference Mean according to the formula: 
 

1
*'

+
+=

r

rr
r n

rnmm  

where: 

 

 

 

 
 
 
5.1.12 REFERENCE REGRESSION 
 
In addition to determining a Reference Mean (see above) a Reference calibration curve can 

be generated: the k-Factor is plotted vs. the sample weight. 

 

The Reference Mean is calculated in case of References of very similar weights. With 

References of considerably differing weights, it is advantageous to generate a Reference 

calibration curve. Measuring a sample afterwards, the k-Factor can be acquired using the 

calibration curve. 

mr’     new Reference Mean 
mr      old Reference Mean 
nr       number of previously measured Reference values (since Reference Start)
r         new Reference value
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Start Reference Regression command 
 
 
 
 

¾ From the Type Menu 

select Start Reference 

Regression. 

 
 

This command corresponds to the Start Reference Mean command (see page 5 – 20). 

The previous Reference value will be deleted. Instead, the result of this current Reference 

measurement will be enlisted as new Reference value. Further References can be added to 

extend the Reference calibration curve. 

 
 

Add Reference Regression command 
 
 
 
 
 

¾ From the Type Menu 

select Add Reference 

Regression. 

 
 
This command corresponds to the Add Reference Mean command (see page 5 – 21). 

A new point on the calibration curve is enlisted. 
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5.2 HYDROGEN MEASUREMENT 
 
5.2.1 DEFINING A GAS CONFIGURATION 
 
 

¾ Open the Continuous Flow module. 
 
 

¾ Open the Gas Configuration Editor. 
 
 

¾ Add a Gas Configuration, if a H2 Gas Configuration is not yet available. 
 
 
 

¾ Select any Gas Configuration as Template or 
H2, if already available. 

 
¾ Type H2 for the Name. 

 
¾ Confirm by OK. 

 
 
 
 
 
 
 

¾ Select a Calibration valid 
for the selected cups. 

 
 

¾ Press Save & Close. 
 
 
 
NOTE: Ensure that a suited Configuration is available. 

To set up a new Configuration refer to Chapter 5.1.2. 
 
NOTE: For detailed information refer to the ISODAT NT Help System (Configurator), 

which is delivered on your ISODAT NT CD. 
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5.2.2 H3-FACTOR DETERMINATION 
 
Protonation reactions in the ion source result in H3

+ ion production. The H3
+ portion of the m/z 

ion beam is determined as H3-Factor. The H3-Factor is used to correct the H3
+ contribution to 

the m/z 3 signal. A low and stable H3-Factor is needed for a good DH/H2 determination. 

 
¾ It is assumed that ion source setting for hydrogen determination and Mass Calibration 

for hydrogen have already been performed. 
 
¾ Standard gases (i.e. CO and H2) are installed. 

 
NOTE:  During the first setup, H3-Factor determination must be performed before 
  any other procedure. Later on, at least once a day, a H3-Factor determination 
  is recommended. 
 
 

¾ Open the Continuous Flow module. 
 
 
H3-Factor determination bases on peak area information of a standard gas on/off chromato-

gram (*.cf) with standard gas pulses of different amplitudes. Chromatograms are stored in re-

sult folders, e.g.: C:\Finnigan\ISODAT NT\Global\User\ConFloIIInterface\Results\ACQ-Re-

sults. 

 
¾ To load it, press the Open button. 

 
 
 
 
 

¾ Localize your *.cf file and press Open. 
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¾ The chromatogram will 
be loaded. 

 
 
 
To see how such a chromatogram is obtained (i.e. via stepwise increases of the reference 

gas pressure using the Method “H2_zero.met”), refer to Chapter 5.2.3. 

 
 

¾ Click the H3-Factor button (on Smart Isotope MS bar or on Isotope MS bar). 
 
 

¾ The H3-Factor is calculated on 
the basis of a chromatogram (*.cf). 

 
 
 
 

¾ Select Top CF Document. 
 
 
 
 
 

¾ Press Determine. 
 
 
 
 



 
 

ISODAT NT          C O N T   F L O W   M E A S U R E M E N T S 5 
 
 

 
5 – 26 

 
     

 
Issue 06/2002 

 
 
 

¾ Confirm the calculated 
H3-Factor by OK. 

 
¾ Upon Cancel, a new H3-Factor 

can be determined. 
 
 
 
The calculated H3-Factor is also displayed in the H3-Factor tab page beneath the 
chromatogram and will be used for further data acquisitions (see Chapter 6.1.2.2). 
 
5.2.3 ZERO ENRICHMENT (ST ON / OFF TEST) 
 
We assume that the user already has some working experience with the system, and that H3-
Factor determination has already been performed (refer to Chapter 5.2.2). It is recommended 
to perform a simple check in order to test the analytical condition of the IRMS before 
measuring any samples. 
 
The following steps need to be performed to define a Method. 
 
 

¾ Open the Continuous Flow module. 
 
 

¾ Select the Configuration (e.g. for ConFlo II/III application). 
 
 

¾ Select the Gas Configuration for 18O determination. 
 
 

¾ Create a new Method or  
 

Select a Method from the File Browser. 
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¾ On the File Browser, click the 
Methods tab. 

 
¾ Double-click the Method 

H2_zero.met. 
 
 
 
 
The Method is structured in Tab-pages: Instrument, Time Events, Evaluation, Peak Detecti-
on, and Printout. 
 
For a detailed explanation of the Method’s structure and editing refer to Chapter 5.1.3. 
 

As a guideline, use the following Method (“H2_zero.met”). 
 

Instrument 
 
 
 
 
 
 

Isotope MS 
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Time Events 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Acq. End Time 
 
 
 
 

Evaluation 
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Peak Detection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Printout 
 
 
 
 
 
 
 

2 Set the ion intensity of mass 2 (H2) to approximately 4 V. 
3 Create a new Sequence or select a predefined Sequence from File Browser. 

 
 
 
 
 

¾ Click the Sequences tab. 
 
 
 

¾ Doubleclick the Sequence file 
H2_zero.seq. 
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¾ Click the Start button. 

 
 
 
 
 
 
 
 
 
 

¾ Edit how to export results. 
 
 

¾ Name folder and file for data 

storage. 

 
¾ Activate or deactivate Printout. 

 
 

¾ Confirm your decision with OK. 
 
 
5.2.4 HOW TO START A HYDROGEN MEASUREMENT 
 

1 Define a Method (as shown in Chapter 5.1.3). 

As a guideline, use the following Method (HD_only.met): 
 

Instrument 
 
 
 
 

Isotope MS 
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Time Events 

 
 
 
 
 
 
 
 

Acq. End Time 
 
 
 

Evaluation 
 
 
 
 
 
 
 
 
 
 
 
 

Peak Detection 
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Printout 
 
 
 
 
 
 

2 Place a sample (e.g. 0.281 mg of benzoic acid) in the solid-autosampler. 

 
3 Create a new Sequence. 

 
 
 
 

4 Define number of samples (e.g. 3). 

 
 
 

5 Edit the Sequence list. 

 
 
 
 
 
 
 

Peak Center  Enable   in order to perform a Peak Center prior to 
measurement. 

Identifier 1  Edit text to identify sample. 
Method   Select IRMS Method. 

 
 

6 Press the Start button. 
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7 Define Results Storage, 

Export, and Printout 

parameters. 

 
 
 
 
 
 

8 Press OK to start 

Sequence Acquisition. 
 
 
Events during Acquisition 
 
 

¾ Peak Center procedure 
 

¾ First H2 Reference Gas pulse activated at 20 s (duration: 20 s). 
 

¾ Second H2 Reference Gas pulse activated at 60 s (duration: 20 s). 
 

¾ Sample is dropped into reactor at 90 s. 
 

¾ H2 sample peak appears approximately 15 s after start of reaction. 
 

¾ Acquisition stops at 160 s. 
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After finishing data acquisition the printer creates a data output sheet as defined by the selec-

ted Results Workshop template (*.irw). 

The Results will also be exported to a spreadsheet file, if activated. 

 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Sample 
drop 

End of 
Acquisition
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5.3 DUAL MEASUREMENT 
 
For the analysis of two isotopic species (hydrogen and oxygen) from a single sample, a 
Method, which comprises both of them must be defined. The acquisition can be completed 
after less than 7 min (400 s). 
 
As soon as the hydrogen peak (3) has been identified, ISODAT NT stops the HD acquisition. 
The magnet jumps to the CO Configuration (see: “Switch Gas” column in the Time Events list 
on page 5 – 40). 
If no hydrogen peak can be found, ISODAT NT waits a certain time (e.g. 25 s). 
After each injection, immediately data acquisition follows. 
 
Schematic chromatogram: 
 

 
 

ST ST
ST ST

1 2 3

   Start of
  HD Acquisition

                         Start of CO Acquisition           End of
           AcquisitionJump to

CO Gas
 Configuration

Acquisition End Time
of HD Method

Amplitude

Time
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5.3.1 HOW TO PERFORM A JUMP CALIBRATION 
 
After determining the H3-Factor (refer to Chapter 5. 2.2), a so-called Jump Calibration must 
be performed. A Jump Calibration calibrates for a fast variation of the magnetic field. 
 
In order to determine the isotope ratios of different elements during the same run, switching 
to another Gas Configuration is necessary. 
 
In contrast to a single element measurement, in which the magnetic field runs the gamut 
from high to low and after that to the pre-calculated magnetic field, there is not sufficient time 
in dual measurement to perform this procedure for the next gas configuration. 
 
For this reason, a Jump Calibration from the first gas configuration to the next gas 
configuration is necessary. 
After the Jump Calibration has been performed, the computer finds exactly the peak center 
even without performing any peak center procedure. 
 
A Jump Calibration should be performed daily to stabilize the performance of the magnet. 
 
NOTE: Both Gas Configurations used (i.e. “H2” and “CO”) need to be calibrated prior 
 to Jump Calibration. 
 
 

¾ Open Instrument Control. 
 
 
 

¾ Choose your Configuration (e.g. “ConFlo II & TC/EA & 
AS”) 

 
 

¾ Turn to the Devices window by pressing this Icon. 
 
 
 
 
 

¾ Open Reference 1 by a click on 
Ref 1 capillary. 

 
Thus, the blue capillary symbol 
elongates and CO enters the 
system. 

 
 

Devices  window 
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¾ Return to the Instrument Control window by this Icon. 

 
 
 

¾ Select Scan > Jump Calibration or alternatively: 
 
 

on the toolbar next to the Instrument Control window 
press the Jump button. 

 
 
 
 
 
 
 

¾ In the list of available 
Jump Calibrations mark 
the one for H2  CO by 
clicking its No. (e.g. 001). 

 
 

¾ Press Recalibrate Icon. 
 
 
 

Slow: compensate hysteresis by Max/Min settings of the magnet. 
 

Fast: magnet setting of Jump Calibration 
 

HV: high voltage setting of Jump Calibration 
 
 
NOTE: If no Jump Calibration is available in the list, create a new one as shown 
 below. 
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Comment: How to create a new Jump Calibration 
 
 
 
 
 
 

¾ Press the New button. 
 
 
 
 
 
 
 
 

¾ From Gasconfiguration select H2. 
 

¾ To Gasconfiguration choose CO. 
 

Accept the default values. 
 
 

¾ Press OK. 
 
 
 
NOTE: Magnet jumps are always from a low mass to a high mass 

(e.g. 2 to 28 at H2 CO or 28 to 44 at N2 CO2). 
 
 
 
 
 

¾ Confirm by Yes, because you have already opened 

the Reference Port. 
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1b 
3b 

 
 
 

¾ Press Yes to start Jump Calibration. 
 
 
 
 
Jump Calibration Procedure 
 

1a Jump to CO (along hysteresis curve). 
1b Perform a peak center for CO in order to get the signal height. 

 
2 Jump to H2 (along hysteresis curve; H2 is origin). 

 
3a Jump to CO (not along hysteresis curve). 
3b Perform a peak center for CO in order to catch the peak. 

 
 
 
 
 
 
 
 
1a 

2 
 

H2 
 
 
 
 
 
 
 
 
 
 
 

Repeat until magnet field setting is within the “magnet window” defined. 
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5.3.2 HOW TO START A DUAL MEASUREMENT 
 

1 Determine a H3-Factor as described in Chapter 5.2.2. 
 

2 Define a Method (as shown in Chapter 5.1.3). 

As a guideline, use the following Method (“HD_CO.met”): 
 

Instrument 
 
 
 
 
 

Isotope MS 
 
 
 
 
 

Time Events 
 
 
 
¾ Double-click on CO 

in the Switch Gas 

column to edit. 

 
(The Event Time is 

active since e.g. 

130 s). 

 
Acq. End Time 
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¾ The Gas Configuration to be switched to 

is selected in the Gasconfiguration menu 
(e.g. “CO”). 

 

¾ The switch will be performed when the peak 
has been found. This is defined in the Event  
menu (e.g. “Isodat@Eval@PeakFound”). 

 

¾ Type in the last jump time at Waiting Time. 
At e.g. 130 s, waiting for the peak begins. If 
a peak is found, the jump takes place. If no 
peak is found, the waiting time elapses befo- 
re the jump takes place. 

 

¾ Select a Post Script, which will be executed 
during the jump. 

 
NOTE: For samples with a high O to H ratio, the activation of the dilution can be 
 directly linked to the magnet jump to CO. In this case, use the He dilution 

Script. 
 
NOTE: For H2 and CO different Evaluation tabs, Peak Detection tabs and Printout 

tabs appear (e.g. “Evaluation@H2”, “Evaluation@CO2”). 
 
 

Evaluation@H2 
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Peak Detection@H2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Printout@H2 
 
 
 
 
 
 NOTE: Usually, the printout of results is performed not until the complete mea- 
   surement has been finished. Therefore, it is recommended to choose “No 
   Printout.irw” at “Printout@H2” tab, because at this moment, data acquisi- 
   tion is still running. Instead, printout options are defined at the end at 
   “Printout@CO” tab. 
 

Evaluation@CO 
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Peak Detection@CO 
 
 
 
 
 
 
 
 
 
 
 
 
 

Printout @CO 
 
 
 
 
 

3 Place a sample (e.g. 0.281 mg of benzoic acid) in the solid-autosampler. 

 
4 Create a new Sequence 

 
 
 

5 Define number of samples (e.g. 3). 
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6 Edit the Sequence list. 
 
 
 
 
 
 
 

Peak Center Enable         to perform a Peak Center prior to measurement. 
 

Weight Type in sample mass [mg]. 
 

Type Select kind of species (e.g. “Sample”). 
 

Identifier 1 Edit text to identify sample. 
 

Method  Select IRMS Method (e.g. “HD_CO.met”). 
 
 

7 Press the Start button. 
 
 

8 Define Results Storage, 
Export and Printout 
parameters. 

 
 
 
 
 
 
 
 
 

9 Press OK to start 
Sequence Acquisition. 
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Events during Acquisition 
 

¾ Peak Center procedure 
 

¾ H2 Reference Gas pulse activated at 20 s (duration: 20 s). 
 

¾ H2 Reference Gas pulse activated at 60 s (duration: 20 s). 
 

¾ Sample is dropped into reactor. 
 

¾ Sample peak (H2) appears approximately 15 s after reaction start. 
 

¾ Sample peak (CO) appears approximately 100 s after reaction start. 
 

¾ CO Reference Gas pulse activated at 340 s (duration: 20 s). 
 

¾ CO Reference Gas pulse activated at 400 s (duration: 20 s). 
 

¾ Acquisition stops at 450 s. 
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ISODAT NT 
 
 

OPERATING MANUAL 
 
 
 
 
 
 
 
 
 
 
 

RESULT HANDLING 
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6.1     HANDLING OF RESULTS 
 
6.1.1     DUAL INLET RESULTS 
 
Toolbar Commands 
 
After the measurement has been started by               , a classical acquisition file, i.e. *.caf, 
is generated (e.g. “Acquisition-7.caf”). The Acquisition window opens. It contains the toolbar 

shown below with the following Icons: 

 
 
 
 
 
 

¾ A running Dual Inlet data acquisition can be 

stopped.  
 

¾ The data are shown both in a data grid and 

graphically (i.e. both in medium size).  
 

¾ The graphical representation of the raw data is 

shown in maximum size (i.e. without data grid).  
 

¾ The result grid is shown in maximum size 

(i.e. without graphical representation).  
 

¾ Some parameters of the Method can be 

changed (not the Method itself). Afterwards, the 

recorded data are reevaluated using the new 

parameter values. 

 

 
¾ Opens a Result Workshop Template containing 

the data (e.g. for preparing a printout).  
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Sequence line 
 
 
 
 
A particular line of the chosen Sequence is shown. It denotes the currently measured 

sample. 

 
The tabs of the Acquisition window 
 
The Acquisition window offers the following tabs for data interpretation: 
 
Raw tab 
 
 
 
 
 
 
 
 
 
 

 

In case of Dual Inlet applications, intensity values are determined (while in case of Conti-
nuous Flow applications, peak areas are calculated). 

 
In the leftmost column, the sample number is displayed (e.g. “Pre” and “1” to “8”; cf. the 

lines of the chosen Sequence). Besides, the raw data grid contains the following columns: 

 
 
1 Int Sample  Sample intensity of a particular mass in mV (e.g. mass 44). 

Each sample mass has a column of its own. 

 
2 Int. Standard Standard intensity of a particular mass in mV (e.g. mass 44). 

Each standard mass has a column of its own. 

1 1 2 2 3 4 4 
5 5 6 
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3 rR    Raw ratio of two masses, i.e. ratio of the intensities of these two 

masses (e.g. rR 45/44). 

 
4 rDelta    Raw Delta of two molecular masses (in ‰) vs. a secondary stan- 

dard - i.e. vs. a user standard. E.g.: rDelta [45 CO2/44 CO2] vs. 

CO2_zero. These values are molecule deltas and are calculated 

from the raw ratios. 

 

5 Delta    Delta value of two element isotopes (in ‰) vs. a primary standard. 

E.g.: Delta [13C/12C] vs V-PDB or Delta [18O/16O] vs V-SMOW. 

These values are element deltas and are calculated from the true 

element sample ratios and the true element standard ratios. The 

true element standard ratios are read from primary standards defi- 

ned in the primary standard database. 

 

6 At %    Atomic percentage value of an isotope, e.g.: At % [13C] or At % 

[18O]. It is calculated from the element delta and the correspon- 

ding absolute element ratio of the standard. 

 
 
Kinds of data in the raw data grid 
 
 

¾ A red value indicates that during integration the 

timeout criterion was reached. Red numbers only 

occur in case of intensities, i.e. in the columns 

Int. Sample and Int. Standard. 
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¾ A black value on a pink background is an outlier 

relating to the particulars given at the “Evaluation” 

tab’s “Outlier Test”: 

 

 
 

If Sigma was selected there and specified by          , 

outliers may occur and are marked as shown above. 

They only occur in case of Delta values, e.g. Delta 

[13C/12C] vs. V-PDB 

 

 
 

If None was selected there, no outliers are calcula- 

ted at all. Therefore, no black values on a pink back- 

ground will occur. 

 

 

 

Suppose, that outliers have occurred (i.e. 

the case of Sigma). If you then decide to 

reevaluate these data using a changed 

Method (yia the Method tab) selecting 

None at the “Evaluation” tab’s “Outlier 

Test”, no more outliers will be calculated. 

Thus, the values will turn into normal 

black ones: 
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¾ A black value on a green background is a 

Normal value falling into the k-fold of σ 

(i.e. no outlier). They only occur in case of 

Delta values, e.g. Delta [13C/12C] vs. 

V-PDB or Delta [18O/16O] vs. V-SMOW. 

 

 
 
Evaluated tab 
 
 
 
 
 
 
 
 
The Delta values (i.e. δ 13C/12C vs. V-PDB and δ 18O/16O vs. V-SMOW) marked pink or 

green in the raw data grid’s columns 5 undergo a statistical analysis here: 

 
¾ δ Mean  Mean of the Delta values noted in column 5 

(e.g. Mean of all Delta 18O/16O values in column 5). 

¾ δ Std. Dev. Standard deviation of the Delta values noted in column 5. 

(e.g. Standard deviation of all Delta 18O/16O values in column 5). 

¾ δ St. Error Standard error of the Delta values noted in column 5 

(e.g. Standard error of all Delta 18O/16O values in column 5). 

¾ Atom-%  Atomic percentage value of the heavier isotope. It is calculated 

from the δ Mean value (e.g. Atom-% of 13C is calculated from δ 

[13C/12C]). 
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¾ Outlier  Number of outliers in column 5 entering into calculation of 

δ Mean, δ Std. Dev and δ St. Error (e.g. 2). 

 
Errors tab 
 
 
 
 
 
 
 
 
 
The “Errors” tab contains detailed information about errors that occurred during Data 

Acquisition: 

 

¾ Number  The consecutive number of the error (i.e. 1; 2; 3…) 

¾ Status  The quality or gravidity of the error (e.g. fatal; warning; error) 

¾ Object  Object in the Script that caused the particular error 

¾ Information Explanation concerning the error 

¾ Script  Script that caused the error 

 
Extended tab 
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In the “Extended” tab, a measurement protocol is presented: detailed information is given 

about particular results during measurement progression (e.g. Peak Center results or Pres-

sure Adjustment results). The kind of information depends on the selected Configuration; 

e.g. different information in case of “Dual Inlet + Microvolume” compared to “Dual Inlet + H-

Device”. 

 
Method tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For Data Reevaluation purposes, some parameters of the Method selected prior to measure-

ment start can be modified (mainly in the “Peripherals” tab and the “Evaluation” tab; click the 

tabs in order to determine the changeable parameters and then type in the new corrected 

values). After the parameters of interest have been modified, reevaluation of the data can be 

started. Therefore, press the Re-Eval button. 
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6.1.2 CONTINUOUS FLOW RESULTS 
 
6.1.2.1 OXYGEN RESULTS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To calculate the standard deviation of delta 29 / 28 (13C16O / 12C16O): 
 

¾ Hold the Shift-key and mark the δ 13C vs. PDB column by a right-click. 

¾ Then choose Calculate and finally look for the Std. Dev. value. 
 
NOTE: The standard deviation of delta 29 / 28 (13C16O / 12C16O) should be < 0.08 ‰. 
 
To calculate the standard deviation of delta 18 / 16 (12C18O / 12C16O): 
 

¾ Hold the Shift-key and mark the δ 18 O vs. V-SMOW column by a right-click. 

¾ Then choose Calculate and finally look for the Std. Dev. value. 
 
NOTE: The standard deviation of delta 18 / 16 (12C18O / 12C16O) should be < 0.1 ‰. 
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6.1.2.2 HYDROGEN RESULTS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A chromatogram with equal peak heights results. Beneath the chromatogram, the correspon-

ding parameter values are listed. 

 
NOTE: The mean value of standard deviation of delta 3/2 should be < 1‰. 
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6.1.2.3 DUAL MEASUREMENT RESULTS 
 
After finishing data acquisition the printer creates a data output sheet as defined by the selec-
ted Result Workshop template (*.irw). The Results will also be exported to a spreadsheet file, 
if activated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The H2 tab reveals information about the hydrogen related peaks. 
 
 
 
 
 
 
 
 

The CO tab reveals information about the oxygen related peaks. 
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6.2 EXCEL EXPORT OF RESULTS 
 
6.2.1 PRINCIPLE OF EXCEL EXPORT 
 

Principle: Measurement parameters and results are exportable as an Excel file. The 

Excel export can easily be tailored to your individual needs. Therefore, rules 

must be established to determine how to perform the export. These export 

rules are described in an export template (i.e. a wke file). 

 
Various selectors, which group Identifiers, are used to create an export 

template. For an export, more than one template can be selected. Multiple 

templates can be used simultaneously. Every single template (i.e. every wke 

file) finally leads to an export file of its own, its wk1 file. Every wk1 file is 

created according to the rules of the wke file. 

 
Advantages: Although measurement data are stored in one result file, the data 

concerning every single gas type can be exported separately to an export 

file of their own (e.g. multigas measurement). 

 
Single parts of a measurement can be exported to an export file of their own 

(e.g. only the Method parameters). 

 
Some types of data can be specified further using query tabs, where 

sophisticated export properties are defined (e.g. peak relevant data). 
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6.2.2 CREATING AN EXPORT TEMPLATE 
 

¾ On the Dual Inlet window’s toolbar, press the New button.                                 

 

 

 

 

¾ Click Data Export and confirm by OK. 

 

Thus, a new export template can be edited. 

 

 

 

 

 

 

 

¾ Four selector types 

can be selected. 

 

 

 

 

 
The four selector types for template creation 

 
Selectors facilitate the Excel-Export: the list of exportable data can be shortened (see the 

Identifiers in the left pane). Without selectors, all exportable data are visible. 
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NOTE: Selectors are always combined by a conjunction (i.e. by an AND relation). 

NOTE: (De-)activation of Selectors can be changed during template creation. 

The export columns will not be affected. 

 
1 Acquisition Mode 

 

 

If Acquisition Mode is activated, choose via click between parameters, which are only 

relevant for Dual Inlet Acquisition and those only relevant for Continuous Flow Acquisition. 

As default, both parameter types are selected, i.e. no selector. 

 

2 Included String 

 

 

 
If Included String is activated and you type a string (e.g. “Delta”), the entries in the left pane 

(“pool”) will be selected according to that string after pressing Apply. The entries that match 

the string will be displayed in the right pane. 

available pool of 

Identifers (columns) 
Identifiers (columns) to be exported 
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3 Gas Configuration 

 

 
If Gas Configuration is activated, choose a Gas Configuration from the list (e.g. “CO2”). All 

relevant data for this Gas Configuration will be shown in the right pane. 

 
4 Data Type 

 

 

 

 
If activated, you can select according to data type. Activate one or more selection criteria 

(e.g. if only “Raw Ratio” is selected, merely entries concerning raw ratios will be displayed in 

the right pane). As default, all data types are activated. Use Disable All or Enable All to 

ease your work with the Data Type selector. 

 
Individual Identifiers 
 
In addition to selectors drag and drop individual Identifiers to the right pane to export them: 

 

 

 

 

 

 

 

 

 

 

 

Every individual identifier will ap- 
 
pear below the panes as a column 
 
in the wk1 Excel sheet. 
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Drag and drop of the Custom Identifier allows inserting a column that contains no data. You 

can give it a name of your own choice. Later on, you can, for example, import data into this 

column. During drag and drop of the Custom Identifier from the left to the right pane, the box 

shown below appears. 

 
 

¾ Type a significant name for the custom 

identifier (e.g. “Identifier 1”). 

¾ Press OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Custom Identifier also appears as a column in the wk1 Excel sheet. To create additional 

empty columns, proceed with the next Custom Identifier(s) by repeating the steps above. 

 

To remove one or more Identifiers (Custom Identifiers or other ones) from the right pane, 

mark them there. Then right-click them. 
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Select Delete Identifier. 
 

 

¾ To remove the Identifier(s) confirm by Yes. 

 

 

 

The selected Identifier(s) will be removed from the right pane together with the provided 

empty columns in the Excel sheet. 

 

6.2.3 SAVING AN EXPORT TEMPLATE 

After creating an export template (i.e. a wke file) it must be saved. Therefore, on the Dual 

Inlet window’s toolbar press the Save or Save As button                            . 
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¾ Save the export template in the 

 folder Wk1 Export Templates! 

¾ In the File Name field, type a signi- 

 ficant name for the export template 

 (e.g. Dual Inlet 1). 

¾ In the Save as type field, accept the 

 extension .wke and press Save. 

 

 

6.2.4 APPLYING AN EXPORT TEMPLATE 

A Sequence is always exported as several samples can thus be bundled into a single export 

file. To apply an export template, open a new Sequence via the New button           . 

 

 

¾ Then click the Sequence Icon. 

 

 

 

 

¾ Confirm by OK. 
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¾ Type your number of samples (e.g. 3). 

 

¾ Confirm by OK. 

 

¾ The Sequence of your choice is displayed. 

¾ Press the Start button         . 

 
 

¾ Since no export templates have 

been selected yet, the Export WK1. 

File box is inactive. 

¾ Press the      button. 

 

 

¾ Since no export templates have 

been selected yet, the Export Temp- 

late list is empty. 

¾ Press the      button. 
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¾ In the folder WK1 Export Templa- 

tes, select your Export Template 

(e.g. Dual Inlet 1.wke). 

¾ Press Open. 

 

 

 

¾ Select your Export Template 

(e.g. Dual Inlet 1.wke). 

 

 

¾ Confirm by OK. 

 

 

 

 

¾ Note that the Export WK1 File box 

has now become active. 

 

¾ Confirm by OK. 
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The options specified in the Sequence are now set and Data Acquisition starts. 

NOTE: The Excel Export will be performed online, i.e. during the measurement. 

 This is different from a Re-evaluation, where the Excel Export takes place 

 offline, i.e. after a measurement. 
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7.1     CHECKING PERFORMANCE DATA 

Thermo Finnigan MAT has developed several test routines to check the performance data of 

isotope ratio mass spectrometers. 

For user's convenience, the program Diagnosis covering these test routines is included in 

the supplied version of ISODAT NT. It must be noted that operating some of the test routines 

requires technical knowledge of the instrument's internals. In addition, successful execution 

of some of the tests depends upon instrument preconditions. 

When running the test routines, a highly sensitive focusing of your instrument will lead to the 

best specifications results. 

The program Diagnosis contains the following test routines: 

1 Absolute Sensitivity 

2 Abundance 

3 Amplifier Test 

4 Compression Factor 

5 Linearity 

6 Peak Flatness 

7 Relative Sensitivity 

8 Resolution 

9 Signal Stability 

10 System Stability 

NOTE: Reference gas for all performance data is CO2. 
Make sure to have properly filled CO2 reservoirs attached to the inlet system 
before starting the “Diagnosis” program. 
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7.2     HOW TO START DIAGNOSIS 

 

¾ Start ISODAT NT by double-clicking the Icon on your desktop. 

 
 

¾ Double-click the Diagnosis Icon. 

 
 
 
 
 

¾ Mark the test routine to be performed 

(e.g. “Abundance”). 

 

 

 

 

 

¾ Press OK. 
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7.2.1     ABSOLUTE SENSITIVITY 

NOTE: Testing Absolute Sensitivity requires a Dual Inlet system 

 

Absolute Sensitivity is defined as the number of molecules needed to generate an ion, which 

is then registered at the collector (e.g. one ion of mass 44 at the corresponding collector 

cup). It is thus dimensionless and measured in molecules per ion. 

 
Based on a defined volume, the ion current is determined during a defined time period as a 

function of sample consumption (i.e. sample loss). The small, defined volume is located 

between valve 25 of the inlet system and the inlet capillary. It amounts to approximately 

250 µl. 

Integrating the ion current over time yields the number of ions. From the signal drop during 

measurement the number of molecules necessary to generate this ion amount is calculated. 

To obtain Absolute Sensitivity, the number of molecules is divided by the number of ions. 

 
Positively charged ions are produced in the ion source by electron bombardment. This 

electron impact (EI) ionization is described by: 

 

 −+− +→+ eABeAB 2  (ionization) 
 

 −+− ++→+ eBAeAB 2  (ionization and dissociation) 
 
 
Definition of Absolute Sensitivity AS: 
 

 )/( ionmolecules
n

sAS
ion

∆=  

 
 
 
where  Δs: sample gas consumption 

nion: number of detected ions 
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The number of consumed sample molecules n is calculated via the ideal gas law: 
 
 
 TRnVp =  
 
where: R: universal gas constant 

T: temperature 

p: pressure 

n: number of sample molecules 

V: volume (here 250 µl) 

 
The amount of detected ions nion in the collector cup can be calculated via the electrons 

needed to neutralize the positive ions: 

 

dtIQ
t

t
∫=
2

1

 

 
where: Q: charge 

 I: intensity 
 
 
To test this parameter 
 
 

1 Measurement starts with a determination of pressure and intensity. 
 

2 The volume is reduced to the defined volume by closing valve 25 of the inlet 

system. The system is in a waiting position until the start pressure and intensity 

are reached. 

 
3 The ion current is measured for the preset time. 

 
 
NOTE: Absolute Sensitivity should be about 1500 molecules CO2 per mass 44 at the 

collector cup. 
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Testing Absolute Sensitivity 

 

 
 
 
 

¾ Click on the Absolute Sensitivity Icon 

and press OK (or double-click on the 

Icon). 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

¾ On the "Window" toolbar, the Absolute Sensitivity Icon 

becomes visible. 

 
¾ Press the Options button. 
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� Accept the defaults or from the pulldown menus, enter 

a value for Stop [s] and choose a value for Delay 

between 100 ms and 20000 ms from the list. 

 

� In Advanced Mode, all values can be edited: 
 

Integration time in ms 
 

Start Intensity value ("Start [mV]") 
 

Minimum Intensity [mV] 
 

Channel: a recording channel consists of an amplifier, a voltage-frequency (VF) 

converter and a counter. 

 

Press Adjust Manual: activate it, if you wish to adjust pressure and peak center 

manually (if it is activated, you are requested to adjust to e.g. 

8000 mV manually). 

 

¾ Finally, click OK. 

 

 

¾ Press the Start button. 
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¾ Testing starts with a Peak Center on the 

selected Cup, e.g. mass 45, Cup3. 

 

The bellow is reduced stepwise until the 

start level intensity (e.g. 8000 mV) is 

reached. Then, intensity and pressure 

are measured for the preset time 

(e.g. 500 s). 

 
 
 
 
 
 
 
 
 
 

 

 
 

 

¾ Finally, Absolute Sensiti- 

vity and other parameters 

are calculated. 

 

 

 



 
 

ISODAT NT           D I A G N O S I S 7 
 
 

 
7 – 8 

 
     

 
Issue 06/2002 

 
¾ Press the Info button. 

 
 
 
 
 
 
 
¾ Original measurement and regression line 

are shown.  

 
 
 
 
 
 
 
¾ When closing the "Absolute Sensiti- 

vity" window you are asked, whether 

to save the changes. 
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7.2.2     ABUNDANCE 
Abundance denotes the contribution of a mass to a neighbor mass (e.g. the amount of ions 

for mass 44 falling into cup 45). Thus, the intensity of a mass (e.g. mass 44) is compared to 

the intensity of the neighboring peak (e.g. mass 45). 

In case of CO2, divide the amount of ion current of mass 44 falling into the mass 45 cup by 

the ion current of mass 44 into the mass 44 cup. 

Measured as ratio of two ion currents it is dimensionless and quoted in % or ppm. The 

Abundance test is performed with CO2, and the device must be calibrated. Peak center is 

performed on Channel 2 (i.e. narrow cup) before the measurement starts. 

 
To test this parameter 
 
 

1 Signal height (i.e. intensity) on mass 44 is determined in the appropriate collector 

cup (e.g. Cup 3). 

 
2 The background signal on mass 45 is measured (i.e. electronic noise with no gas) 

from mass 44 to mass 45.5. 

 
3 With CO2 as sample gas the magnetic field is scanned from mass 44 to mass 45.5, 

and the intensities are measured on the neighboring Cup of mass 45 (e.g. Cup 4, 

with bigger resistor value in order to keep the signal in the detection range). 

 
4 Extrapolate the abundance (of mass 44 onto mass 45) from the signal to the left and 

to the right of mass 45 peak. 

 
5 Calculate the abundance as described above. 
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Sources of error 
 
¾ Resistor values are not configured correctly. 

¾ Due to electrons on the left and on the right side of the peak, a negative signal may 

result. This problem can be overcome by manual adjustment. 

 
Testing Abundance 
 

 
 
 
 
¾ Click on the Abundance Icon and press OK 

(or double-click the Icon). 

 
 
 
 
 
 
 
 
 
 
¾ The left window detects mass 44 

 ions in the correct cup. The right 

window detects mass 44 ions in 

the neighbor cup (i.e. cup of 

mass 45). 
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¾ On the "Window" toolbar, the Abundance Icon becomes visible. 

 

¾ Press the Options button. 

 
 

� Accept the defaults, or type appropriate values for 

"Press Adjust [mV]" and "Peak Width [Dalton]". 

The selected cup for the Abundance test is 

connected with the indicated recording channel (e.g. 

choose channel 2 from the pulldown list). 

Choose a "Delay [ms]" value between 100 ms and 

20000 ms. The measurement start will be delayed 

by it. 

 

In Standard Mode, the inactive, i.e. gray, variables 

cannot be edited. The Advanced Mode allows 

experienced users to set them all: 

 

� the start mass for the magnet field scan ("Start [Dalton]"), 

� the end mass, where the magnet stops scanning ("Stop [Dalton]") 

� the step width for the magnet scan ("Step [Dalton]") 

� the "Adjust Manual" check box - if it is activated, signal intensity and peak 

center must be performed manually. 

 

¾ Finally, click OK. 

¾ Start the Abundance test by the Start button. 
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¾ Testing starts with a Peak Center on the 

selected cup (e.g. mass 45, cup 3). 

 

¾ It might be helpful to activate the 

Advanced Mode, press the Options 

button and enhance the interval between 

"Start" and "Stop" values (i.e. decrease 

"Start" and increase "Stop" values). 

 

 

 

 

 
 
 
 
 
¾ Values for Abundance, Intensity, 

δU and slope are displayed. 

 
 

 
 
 
 
 
¾ When closing the "Abundance" 

window you are asked whether 

to save the changes. 
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7.2.3     AMPLIFIER TEST 

The Amplifier Test (formerly called UFC-Test) checks the ion detection performance of the 

IRMS with no ions present. It thus informs about the background noise of electronic devices. 

 
The amplifier baseline must be determined without an interfering signal. Thus, the ion source 

is switched off before measurement starts (i.e. ion current equals zero). The signal intensity 

of every cup is individually measured at least 200 times for a defined integration time. Finally, 

mean and standard deviation are calculated. 

 
Testing Amplifiers 
 

 
 
 
 
¾ Click the Amplifier Test Icon and press OK 

(or double-click the Icon). 

 

 

 

 

 

 

 

 

¾ Wait, while the available Gas Configurations 

are scanned. 
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¾ On the "Window" toolbar, the Amplifier Icon becomes visible. 

 
 
 
¾ Press the Options button. 

 
 
¾ With the exception of Delay, all parameters are preset and 

not changeable in Standard Mode. 

 
� The Advanced Mode allows experienced users to modify 

all parameters. 

� Accept the default value of Integration Time (in ms). 
 

� Scan Time (in s) denotes the duration of the scan. 

� The measurement start is delayed by the displayed de-
fault value of Delay time (in ms). Accept it, or from the 
pulldown menu, select a suitable value between 100 ms 
and 35000 ms. 

 
NOTE: In one of the next versions, the process will be simplified: all amplifiers 

can then be measured using one single Scan. 
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� Cycles denotes the number of measurements. The intensities of the channel are 
measured for indicated cycles with a definite cycle time. 

 
 
¾ Finally, press OK. 

 
¾ Press the Start button. 

 

 

 

¾ Switch off High Voltage (on the Focus bar). 

Then press OK. 

 

 

 

 

 

 

 

 

¾ The amplifiers of the cups activated in step 5 are being tested, 

e.g. cup 1, mass 2, brown and cup 8, mass 3, green. 

 

¾ If you press the Options button during measurement, a green 

arrow informs you about what is currently done. 
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¾ The correspondent intensity vs. 

time diagram is shown. 

 

 

 

 

 

 

 

 

 

 

¾ The baselines of the cups are 

shown with no ions present. 

 

Standard deviation [mV], mean [mV] 

and resistance [Ohm] of each selec-

ted cup are displayed. 

 

 

¾ The procedure is repeated for the other masses. 

 

 

¾ When closing the "Amplifier Test" 

window you are asked, whether to 

save the changes. 
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7.2.4     COMPRESSION FACTOR 

NOTE: Testing Compression Factor requires a Dual Inlet system. 

The Compression Factor, formerly called Pressure Ratio, is defined as intensity ratio and is 

thus dimensionless [mV/mV]: 

start

end

Int
IntComp =  

where: 

Intend: Intensity at the end of measurement 

Intstart: Intensity at measurement start 

 

The Compression Factor determines the dynamic range of the two bellows informing about 

their tightness and linearity. The ion signal (i.e. intensity) is measured at different bellow com-

pressions: an intensity vs. volume diagram results. The standard deviation around the sig-

nal's mean is calculated. 

 
NOTE: The bellows must be calibrated before performing the test. 
 

To test this parameter, the peak intensity for a mass (e.g. 44) is measured starting at the 

maximum (i.e. 100 %) down to the minimum (i.e. 0 %). A minimum death volume of about 3 

ml is still remaining at 0 % volume. A certain level (e.g. 200 mV) serves as starting point of 

the measurement. The signal for the bellow expanded to maximum should be at this level. If 

it is not the case, the inlet system is expanded and pumped automatically until the reference 

level is reached. 

 
NOTE: The Compression Factors should be about the same for both bellows: 

at least 1:10 or higher. 
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Testing the Compression Factor 
 

 

 

 

¾ Click on the Compression Factor Icon 

and press OK (or double-click the Icon). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¾ On the "Window" toolbar, the Compression Factor Icon 

becomes visible. 

 

¾ Press the Options button. 
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¾ In Standard Mode, you are only able to select a 

channel from the pulldown menu. 

 
In Advanced Mode, also the other variables can be 

edited: 

 
� Integration time [ms], 

� Steps: the volume of the bellows is varied 

stepwise, e.g. in 10 steps, 

� Delay [ms]: the measurement start is delayed 

by the displayed value. 

 
¾ Finally, press OK. 

 
¾ Press the Start button. 

 

 

 

 

 

¾ Testing starts with a Peak Center for the 

first bellow (e.g. Sample). 
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¾ When the Peak Center is finished, 

signal intensity is shown during the 

volume change of the bellows (for 

the different masses). 

 

Finally, the Intensity-Compression 

ratio is calculated for the first 

bellow, e.g. Sample. 

 

 

 

 

 

 

 

 

¾ The procedure is repeated for the second 

bellow (e.g. Standard): a Peak Center is 

performed. 
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¾ The procedure is repeated for the 

second bellow (e.g. Standard). 

 

When the Peak Center is finished, 

an Intensity vs. Volume diagram 

for the different masses is shown. 

Finally, the Intensity Compression 

ratio is calculated for the second 

bellow (e.g. Standard). 

 

 

 

¾ When closing the "Compression 

Factor" window you are asked, 

whether to save the changes. 
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7.2.5     LINEARITY 

At Linearity test, synonymously called Ratio Linearity, over a range of varying signals, signal 

linearity is checked vs. beam intensity (i.e. intensity of the main ion current). The signal 

intensity is measured, and the isotope ratios are displayed vs. beam intensity. Linearity is 

calculated as slope of the regression line [‰/V]. The ratios are monitored between 2 V and 8 

V in 1 V steps. For each data point, the background is subtracted. 

 

Source of error: Resistor values must be configured correctly. 
 
 
Testing Linearity 
 
 
 
 
 
 
 
 

¾ Click the Linearity Icon and press OK 

(or double-click the Icon). 
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¾ On the "Window" toolbar, the Linearity Icon becomes visible. 

 
 
 
 
¾ Press the Options button. 

 
 
 
 
¾ From the pulldown menus select: 

 
� a channel and a value between 100 ms and 

20000 ms for "Delay [ms]". 

The other variables are preset in Standard Mode (to 
be accepted), but editable in Advanced Mode: 

� Integration time [ms], Start [mV], Stop [mV] Step width 

[mV], V-Window [mV] 

� Adjust Manual:  activate it, if the intensities (i.e. 

voltage steps) between 2 V and 

8 V are to be set manually. 

 
¾ Finally, press OK. 

 
 
 
¾ Press the Start button. 



 
 

ISODAT NT           D I A G N O S I S 7 
 
 

 
7 – 24 

 
     

 
Issue 06/2002 

 
 
 
 
 
¾ Testing starts with a Peak Center on cup 3 as the 

narrow cup. 

 
 

If no peak could be found, the measurement will 

be terminated. 

 

 
 
 
¾ Two linearity values [‰/V] are cal- 

culated: one for mass 45/44 and 

one for mass 46/44. 

 
 
 
NOTE: Linearity must be less 
 

than 0.06 ‰/V! 
 
 
¾ Press the Info button. 

 
 
 
¾ Mean and slope values are displayed. 
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7.2.6     PEAK FLATNESS 
 
As slope of the peak plateau, Peak Flatness reflects the quality of the ion stream. A 

correction is necessary to eliminate effects of descending peak plateau with increasing high 

voltage. This is done by measuring the peak twice - first with increasing and then with 

decreasing high voltage. The resulting peak represents the mean values of both runs. The 

measured intensity is a function of the acceleration voltage (i.e. ion energy). Therefore, 

during a high voltage scan the intensity is slightly affected by this effect. To overcome this an 

"energy correction" is performed. The ion intensity on top of the peak (i.e. at a parameterized 

mass range around the center) is measured. Peak Flat-ness can be determined for different 

gases and different collector cups (e.g. for a CO2-peak at mass 45 at Cup 2). 

 
Two results are obtained: 

¾ Maximal intensity deviation divided by the intensity 

¾ Slope of the regression line [1/Da] 

 
Differences to ISODAT Old 
 

¾ Slope of the regression line as additional result 
 

Dividing System Stability by this slope yields a measure for Signal Stability with 

respect to high voltage or magnet current instabilities. 

It is complementary to the Diagnosis parameter Signal Stability which is also sensi-

tive to emission fluctuations. 

 
¾ Parameterized mass range 

 
In ISODAT Old, a certain proportion of the peak top (30%) is used instead of a 

parameterized mass range. However, to know how much the measurement is 

affected by a certain system drift, remember that this is a proportion of mass scale 

rather than of cup width. The default mass range is set in such a way that the final 

result is comparable to the one of ISODAT Old using a typical cup width. 
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Testing Peak Flatness 

 

 
 
 
 
¾ Click on the Peak Flatness Icon and press 

 
OK (or double-click on the Icon). 

 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
¾ On the "Window" toolbar, the Peak Flatness Icon becomes visible. 

 
 
 
¾ Press the Options button. 
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� Accept the defaults or from the pulldown menus, select 

a Channel and a Delay value between 100 ms and 

20000 ms. 

 
� Accept the default, or choose an appropriate Peak 

Width value by the < or > buttons. 

 
� If you simply want to accept the Peak Detection 

parameters without a glance, do not press the Peak 
Parameter button. Instead, click OK. 

 
� However, as a sophisticated user, you may want to look 

at the Peak Detection parameters. To do so, press the 

Peak Parameter button. 

 

 

 

 

 

¾ Change the values according to your needs. 
 
 
 
 
 
¾ Then click OK. 

 
 
 
 
¾ Press the Start button. 
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¾ Testing starts with a Peak Center on the 

 
selected cup (e.g. mass 45, cup 3). 

 

 

If no peak can be found, the measurement 

will be stopped. 

 
 
 

In this case, press Cancel to proceed. 
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¾ A Peak Center for Energy Correction is 
 

performed. 
 
 

If no Peak Center can be found, the 

measurement will be stopped. 

 
 

In this case, press Cancel to proceed. 

 

 
 
 
 
 
 
 
 
¾ Values for Peak Flatness, 

 
normalized slope [Da-1] 

 
and Peak Width [Da] are 

 
calculated. 
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¾ Press the Graphic tab to view relevant data. 
 

 

 

 
 
 
 
 
 
 
¾ Press the Graphic 2 tab to view relevant data. 

 
 
 
 
 
 
 
 
 
 
 
¾ When closing the "Peak Flatness" 

 
window you are asked whether to 

 
save the changes. 
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R
U

p
Srel

1
69.0
1=

7.2.7     RELATIVE SENSITIVITY 
 
Relative Sensitivity (Srel) describes the dependency of signal intensity (i.e. ion current) on the 

ion source pressure and is thus given in A/mbar: 

 
 
 
 

where: 
 

U: voltage measured at the amplifier of the collector cup (e.g. Cup 3, mass 44) 

R: resistor value (e.g. 3 * 10 8 Ω for mass 44). This value is the same for N2 and 

CO2 as reference gases. It needs to be changed in special cases only. 

∆ p: pressure difference between a measurement with and without reference gas. 

0.69: correction factor for CO2. The ion gauge is calibrated with N2, however, which 

has a different ionizing probability. The correction factor takes this into account. 

To calculate it, intensities (i.e. ion currents) and pressures are measured with 

and without reference gas. 

 
NOTE: Two different Relative Sensitivity values exist depending on whether the 

instrument is equipped with a differential pumping system or not. The 
difference is due to different pressure readings at the same flow. The 
Absolute Sensitivity (given in molecules/ion) however, is the same. 

 
After a cycle of e.g. three measurements and calculations of Relative Sensitivity a mean 

value is displayed. This value should be about 0.2 A/mbar for a standard system and about 

0.5 A/mbar in case of a differentially pumped system. They depend on the pumping capacity 

of the turbomolecular pumps. Each cup (i.e. each mass) is characterized by a Relative 

Sensitivity value of its own. 

Different values of Relative Sensitivities can only be compared, if pumping speed, 

conductance, location of the ion gauge etc. are identical. Therefore, it is senseless to 

compare different types of instruments. 
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Sources of error 
 
¾ Resistor values must be configured correctly. 

¾ Relative Sensitivity depends on the accuracy of the high vacuum pressure gauge’s 

accuracy, which is limited. 

 

Testing Relative Sensitivity 

 

 
 
 
 
 
¾ Click the Relative Sensitivity Icon and 

press OK (or double-click the Icon). 

 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

¾ The cups with the corresponding masses and resistor values are shown. 
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¾ On the "Window" toolbar, the Relative Sensitivity Icon becomes visible. 

 
 
¾ Press the Options button. 

 
 
 
 

 
¾ Press OK. 

Experienced users can change the values via the 

Advanced Mode. 

 
 
¾ Click the Start button. 

 
 
 

 

 
 
 
 
 
 
 
 
¾ Finally, for each cup, the values of three cycles and their mean are displayed. 

 

¾ When closing the "Relative Sensiti- 

vity" window you are asked, whether 

to save the changes. 
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7.2.8     RESOLUTION 
Resolution describes the masses, which can be separated from each other (i.e. the minimal 

relative distance between two masses, which can be resolved). Different definitions of 

resolution are used in mass spectrometry. 

 

 

¾ The 10% valley definition, commonly used for double 

focusing sector field mass spectrometers, means: 

 
Resolution can be defined as: 

 

1 Mass divided by the mass difference of two neighboring peaks, if the valley between 

the peaks drops to 10% of the peak height, or as 

 

2 Mass divided by the peak width (in Dalton) at 5% of peak height. 

 

According to the 10% valley definition, it is dimensionless (given in m/∆m): 

m
mR

∆
=  

where: 

 
R: Resolution 

m: Mass of the interesting isotope 

∆m: Mass difference between neighboring peaks 

 
In Dual Peak mode, the distance between Peak Centers of two neighboring peaks is 

measured [Da]. The peak width of one peak is measured at 5% peak height. 

 
In Single Peak mode, the distance between neighboring peaks is set to 1 Da. In both 

modes, Resolution can be calculated as follows (the mass difference is usually 1 Da): 
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b
a

m
mR

∆
=  

 
where: 

 
a: distance between peak centers 

b: peak width of the isotope of interest 

 
Resolution is determined using the narrowest cup (i.e. usually Cup 2). Mass 45 is used. 

 
Example 
 
For a resolution of 88 and mass 44, a peak with a distance of (44/88) Da = 0.5 Da could be 

resolved using the 10% criterion. 

 
Start mass and end mass of the magnetic field scan can be edited. In case of CO2, the mass 

ranges from about 43 to 45.5. The BDAC values referring to the masses 44 and 45 are 

determined and the Resolution is calculated. 

 

Testing Resolution 
 

 
 
 
 
¾ Click on the Resolution Icon and press OK 

(or double-click the Icon). 
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¾ On the "Window" toolbar, the Resolution Icon becomes visible. 

 
 
¾ Press the Options button. 

 
 

 
¾ Accept the defaults or from the pulldown menus, select a 

Channel and a Delay value between 100 ms and 20000 

ms. 

¾ If you simply want to accept the Peak Detection parame- 

ters without a glance, do not press the Set button. 

Instead, click OK. 

¾ However, as a sophisticated user, you may want to look 

at the Peak Detection parameters. To do so, press the 

Set button. 
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¾ Change the values or accept the defaults. 

 

 

 

¾ Then click OK. 

 
 
 
¾ Press the Start button. 

 

 

 

 

 

 

¾ Testing starts with a Peak Center on the 

selected cup (e.g. mass 45, cup 3). 

 
� If no peak could be detected, 

 the measurement is stopped. 

 
� If not enough peaks could be detected, 

 an error message occurs. 
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¾ Finally, the values of Peak Distance [Da], Peak Width at 10% Height [Da] and Reso- 

lution are displayed. 

 

 

¾ Click the Info button. 

 
 
 

 

 

 

 

¾ Press the Graphik tab. 
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¾ Press the Peaks tab. 

 
 

 
 
 
 
 
 
 
 
¾ When closing the "Resolution" 

window you are asked, whether to 

save the changes. 
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7.2.9     SIGNAL STABILITY 

Signal Stability describes the stability of the intensity (i.e. peak height). The intensity on top of 

the peak is measured for a limited period of time (e.g. 5 min). Note the similarity to the 

System Stability, but here, the stability is not measured at the peak flank, but at the peak 

center. The value of Signal Stability should be about 2 * 10 -4 (for 5 min). 

Two results are obtained: 

 
¾ Slope of the regression line (normalized by the intensity) 

¾ Standard deviation of the regression line (normalized by the intensity) 

 
Testing Signal Stability requires a signal of 3 V or more! 

 
Sources of error 
 

¾ The slope is usually due to gas consumption during measurement. However, it 

should be checked, if an unusual result is obtained. 

¾ Instabilities of the emission may cause an unstable signal although a stable high 

voltage and magnetic field are given. 

¾ Pressure fluctuations (check the oil of the forevacuum pumps!) or temperature 

fluctuations particularly at the crimps. 

 
Differences to ISODAT Old 

 
1 In ISODAT Old, maximum deviation is reported instead of standard deviation. 

However, for a statistical process standard deviation is more relevant as it is less 

sensitive to measuring time and outliers. 

2 Conversion of results to the ISODAT Old scale: Multiplication by a factor of 

approximately four. 
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Testing Signal Stability 

 

 

 

 

¾ Click the Signal Stability Icon and press 

OK (or double-click the Icon). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¾ On "Window" toolbar, the Signal Stability Icon becomes visible. 

 

¾ Press the Options button. 
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¾ From the pulldown menu, select a delay value bet- 

ween 100 ms and 20000 ms. 

 

¾ Click OK. 

 

 

¾ Press the Start button. 

 

 

 

 

 

¾ Testing starts with a Peak Center on the 

selected Cup (e.g. mass 45, Cup 3). 
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¾ Another Peak Center is performed. 
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¾ Finally, values of slope [1/min], Signal Stability and the Cup number are displayed. 

 
¾ Press the Info button. 

 

 

 

¾ Press the Graphik tab. 

 

 

 

 

¾ When closing the "Signal Stabi- 

lity" window you are asked 

whether to save the changes. 
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7.2.10     SYSTEM STABILITY 

System Stability informs about high voltage stability and thus magnetic field stability. Already 

small variations of high voltage or magnetic field dramatically influence signal intensity: They 

cause peak shifts. The fluctuations of high voltage or the magnetic field strength are measu-

red at the peak flank, because they exert a much higher impact on peak intensity at the flank 

than on top. 

 
The System Stability test comprises the following steps: 
 

¾ Determination of peak center and peak flanks 

¾ Set magnetic field to 50% of peak height (at the peak flank). 

¾ Measurement of signal intensity (high voltage fluctuation) at the peak flank 

for a defined period of time (e.g. 15 min). 

¾ New peak center procedure 

¾ Calculation of System Stability [min-1] and Relative Mass Drift [min-1] 

(either electronic or to magnetic drift) using the slope of the peak flank. 

 

Testing System Stability requires a signal of 3 V or more! 
 
Two results are obtained: 
 

¾ Slope of relative mass drift vs. time (time drift) 

¾ Standard deviation of this slope (scatter of the mass) 

A value of 5*10-4 measured for a period of 15 min reflects a good System Stability. 
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Differences to ISODAT Old 

 
¾ The slope is a new, but important parameter, as it shows the effect of slow 

fluctuations in temperature, supplied voltage etc. 

 
¾ In ISODAT Old, maximum deviation is reported instead of standard deviation. 

However, for a statistical process, standard deviation is more relevant as it is less 

sensitive to measuring time and outliers. 

 

¾ Conversion of the Results to the ISODAT Old scale: multiplication by a factor. 

 
Testing Signal Stability 

 

 
 
 

¾ Click the System Stability Icon and press OK 

(or double-click the Icon). 
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¾ On the "Window" toolbar, the System Stability 

Icon becomes visible. 

 

¾ Press the Options button. 

 

¾ If you simply want to accept the Peak 

parameters without glancing at them, do not 

press the Peak Parameter button. Instead, click 

OK. 

 
¾ However, as an experienced user, you may want 

to look at the Peak parameters. To do so, press 

the Peak Parameter button. 

 
¾ Experienced users may further want to change 

the gray default values (from Integration Time to 

Scan Time). This can be achieved via 

Advanced Mode. 

 

 

 

 

 

¾ Make your changes or accept the 

defaults. 

 

 

 

¾ Then press OK. 
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¾ Press the Start button. 

 

 

 

 

 

 

 

¾ Testing starts with a Peak Center on the 

 selected Cup, e.g. mass 45, Cup 3. 
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¾ Testing continues with another Peak 

  Center on the selected Cup. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¾ Finally, values for System Stability [min-1] and Relative Mass Drift [min-1] are 

displayed. 
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¾ Press the Info button. 

 

 

 

 

¾ Pressing the Graphik tab, the 

diagram for calculating Slope and 

Mass Drift is shown together with 

the respective values. 

 

 

 

 

¾ When closing the "System Stabili- 

ty" window you are asked whether 

to save the changes. 
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